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1 はじめに 
 本技術レポートは、NGN 環境下にて JT-Q3402 に従った SIP による呼確立後、SOAP/HTTP を利用して通

信システム間でコンテンツの送受信を実現するために作成した。 

 

2 参照文献 
 本技術レポートで参照する文献を以下に示す。 
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JF-IETF-RFC4145, 情 報 通 信 技 術 委 員 会  (The Telecommunication Technologies 

Committee), 2007 年 3 月 
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3 用語 
コンテンツ : 画像、映像、文書等のデジタルデータ 

コンテンツ転送 : コンテンツを送り届けること 

アウトチャネル : 電話番号を利用し、呼設定を行う信号チャネル 

インチャネル : アウトチャネルにて呼設定後、機器間でメディア情報をやりとりするチャネル 

発呼  : 電話番号を使って呼設定の要求を開始すること 

着呼  : 呼設定の要求を受信すること 

発呼機器  : 本仕様で規定する通信手順を用いて呼設定の要求をする機器 

着呼機器  : 本仕様で規定する通信手順を用いて呼設定の要求を受信する機器 

機器  : 発呼機器、着呼機器を示す 

送信機能  : 本仕様で規定する通信手順を用いてコンテンツを送信する機能 

受信機能  : 本仕様で規定する通信手順を用いてコンテンツを受信する機能 

クライアント機能 : コンテンツ転送を行うための要求を送信する機能 

サーバ機能 : コンテンツ転送を行うための要求を受け付ける機能 

NGN  : 電話・データ通信・ストリーミング放送が融合したマルチメディアサービスを 

実現する、インターネットプロトコル技術を利用する次世代ネットワーク 

（Next Generation Network） 

UNI  : 通信事業者の通信設備とエンドユーザー側の設備とを接続するインタフェース仕様 

（User-Network Interface） 

BN 記法  : バッカス・ナウア記法（Backus-Naur Form）のこと。文脈自由文法を定義するのに 

用いられるメタ言語のことで、プロトコル規定言語である ASN.1 や、XML の構文 

定義に利用されている 

HTTP  : サーバとクライアント間でデータを送受信するのに使われるプロトコル 

XML  : 文書やデータの意味や構造を記述するためのマークアップ言語 

SOAP  : XML と HTTP などをベースとした、他のコンピュータにあるデータやサービスを 

読み出すためのプロトコル 

SOAP HTTP Binding : SOAP メッセージの伝送に HTTP リクエストおよびその HTTP レスポンスを 

利用すること 

準正常系  : 規定通りの動作を行っても組み合わせによっては起こりうるケース 

異常系  : 利用上、特別なことを行った結果起こる異常なケース 

 

AnnexA 

F コード  : TTC 標準 JT-T33 で定義されたサブアドレス情報を用いて、情報通信ネットワーク産業 

協会（CIAJ）が定めた FAX アプリケーションの実現手段。親展、掲示板、同報、 

回覧板の各機能を実現する。プロトコルは、HATS で規定されている。 

 

AnnexB 

センターマシン : リモートメンテナンスに関する情報収集及び対応指示を発信するマシン機器は、常 

  に本センターマシン間で通信を行う 
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4 本技術レポートの構成 
本技術レポートは、本編として、コンテンツファイルの取得、送信、受信の基本的な通信プロトコルを規定

し、付属資料は本編を基本として付加的な情報を伝えるためのプロトコルを規定する構成とする。付加的な

情報とは、本編の規定を拡張して、送信機器、受信機器でコンテンツファイルを扱うための情報である。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 4-1／TR-1038 本技術資料の構成 

 

4.1 本技術レポートの改版 

本編および付属資料の内容が改版されたとき、本技術レポートを改版する。改版によってプロトコルが変更

される場合は、9.1 項のプロトコルバーションを改版する。 

 

4.2 注意事項 

4.2.1 構文の記述 

本技術レポートで記述する HTTP 構文、XML 構文は、BN 記法に従い記述する。 

各構文の記述内容は、2 項の各参考文献を参照のこと。 

 

■本編 

コンテンツの取得、送信、受信を提供するアプリケーションの基礎的な動作を規定する  

 

 

 

 

 

■付属資料 

本編を基本として、特定のアプリケーションに必要とされる付加的な動作を規定する 

■Annex・・ ■AnnexB 
■AnnexA 
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4.2.2 XML要素のネームスペース 

本プロトコルで定義する XML 要素のネームスペースは 

 

本編 :  http://www.ttc.or.jp/mmsys/ct 

AnnexA :  http://www.ttc.or.jp/mmsys/ct/cta 

AnnexB :  http://www.ttc.or.jp/mmsys/ct/ctb 

 

とする。お互いに参照して利用して構わない。 

 

5 システムモデル 
コンテンツ転送システムにおける送信処理について、データの流れから見た典型的な送信機器モデルを 図 

5-1 に示す。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 5-1／TR-1038 データの流れから見た送信機器モデル 
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コンテンツ転送システムにおける受信処理について、データの流れから見た典型的な受信機器モデルを 図 

5-1 に示す。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 5-2／TR-1038 データの流れから見た受信機器モデル 
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6 プロトコル構成 
プロトコル構成は OSI 参照モデルに即した階層構造とする。 

JT-Q3402 に従い SIP による呼確立後、SOAP/HTTP を利用したインチャネルの本プロトコルによりコンテン

ツ転送を実現する。本プロトコルはインチャネルのプロトコル規定のため、NGN に限らず何らかの手段で

相手機器に接続した後に本プロトコルを使用してコンテンツ転送を実現することができる。 

 

表 6-1／TR-1038 プロトコル構成 

レイヤ 
使用プロトコル 

アウトチャネル インチャネル 

7 アプリケーション 

SIP,SDP 

SOAP 

HTTP 6 プレゼンテーション 

5 セッション 

4 トランスポート UDP TCP 

3 ネットワーク IPv4/IPv6 

2 データリンク Ethernet 等 

1 物理 

 

＜SOAP/HTTP 使用の理由＞ 

本コンテンツ転送プロトコルでは以下の理由によりインチャネルで SOAP/HTTP を利用する。 

(1) TCP コネクションを用いた通信プロトコルにおいて、HTTP が最も利用されているプロトコ

ルである。 

(2) SOAP は WEB サービスの広まりと共にリモート・プロシージャコール(RPC)の標準として利

用されている。 

(3) 多くの開発環境が整備されており、短期間での開発が可能である。 

(4)  SOAP 上で関数定義が自由に実現できるため拡張が容易である。 

 

6.1 SIP、SDP 

本プロトコルで規定するコンテンツ転送は、SIP セッションの中で行う。 

TTC 標準 JT-Q3402 に準拠する。 

 

6.2 TCP 

HTTP パケットの転送に関して、トランスポート層のプロトコルとして JF-IETF-RFC4145 に従い TCP を利用

する。 

 

6.3 HTTP 

コンテンツ転送に利用する。RFC2616（HTTP1.1）に準拠する。 

また、SOAP メッセージを HTTP のメッセージボディに載せて通信相手に送る。（SOAP HTTP Binding） 
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6.4 SOAP 

SOAP1.2 に準拠する。 

 

6.5 SOAP HTTP Binding 

SOAP Version1.2 Part2 に従い、SOAP メッセージの伝送に HTTP リクエストおよびその HTTP レスポンス

を利用する。SOAP Request-Response Message Exchange パターンに準拠する。 

 
 

7 プロトコルの規定範囲 
7.1 規定範囲 

本プロトコルは，アウトチャネルにて JT-Q3402 に従い SIP による呼確立後、SOAP/HTTP を利用したインチ

ャネルのプロトコルを 3 つ規定し、機器間のコンテンツの転送を実現する。 

 

7.1.1 インチャネルプロトコル規定１ 

発呼機器からコンテンツが複数保管されているコンテンツサーバに発呼し、コンテンツサーバからのコンテ

ンツリストを基に発呼機器がコンテンツを取得する接続形態のプロトコル規定。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 7-1／TR-1038 インチャネルプロトコル規定 1 の範囲 
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7.1.2 インチャネルプロトコル規定２ 

発呼機器から着呼機器に発呼し、発呼機器から着呼機器にコンテンツを送信する接続形態のプロトコル規定。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 7-2／TR-1038 インチャネルプロトコル規定 2 の範囲 

 

 

7.1.3 インチャネルプロトコル規定３ 

発呼機器から着呼機器に発呼し、着呼機器から発呼機器にコンテンツを送信する接続形態のプロトコル規定。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 7-3／TR-1038 インチャネルプロトコル規定 3 の範囲 
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7.2 アウトチャネルの接続形態 

アウトチャネルで行う、SIP/SDP による呼設定は、表 6-1 に示す 2 つの形態を定義する。 

 

表 7-1／TR-1038 アウトチャネル接続形態の説明 

接続形態 説明 

1 単独呼 コンテンツ転送のみを行うために SIP セッションを確立する呼 

2 追加呼 
既に存在する、音声、映像、データ通信の呼に追加してコンテン

ツ転送を行うために SIP セッションを追加する呼 

 
 

7.3 インチャネルの接続形態 

インチャネルで行うコンテンツの転送方法は、表 7-2 に示す 3 つの接続形態を定義し、それぞれの接続形態

に表 7-3 のインチャネルプロトコル規定を適用する。 

 

 

表 7-2／TR-1038 インチャネル接続形態の説明 

接続形態 説明 

1 
発呼側 

コンテンツ取得 

発呼機器から着呼機器にあるコンテンツを取得する 

2 
発呼側 

コンテンツ送信 

発呼機器にあるコンテンツを発呼機器から着呼機器に送信する 

3 
着呼側 

コンテンツ送信 

着呼機器にあるコンテンツを着呼機器から発呼機器に送信する 

 

表 7-3／TR-1038 インチャネル接続形態とプロトコル規定の適用 

接続形態 適用するプロトコル規定 

1 
発呼側 

コンテンツ取得 

7.1.1 項「インチャネルプロトコル規定 1」 

2 
発呼側 

コンテンツ送信 

7.1.2 項「インチャネルプロトコル規定 2」 

3 
着呼側 

コンテンツ送信 

7.1.3 項「インチャネルプロトコル規定 3」 
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7.4 コンテンツ転送の各通信フェーズ 

コンテンツ転送には、SIP/SDP による呼を確立する呼設定フェーズ、呼を切断する呼切断フェーズを行うア

ウトチャネルと、呼確立後に TCP コネクションを確立するフェーズ、コンテンツ送信側からコンテンツ受信

側へ能力を問い合わせる能力通知・確認フェーズ、取得できるコンテンツの一覧を把握するコンテンツリス

ト取得フェーズ、コンテンツファイル転送のジョブを生成するジョブ生成フェーズ、コンテンツファイルを

転送するコンテンツ送信フェーズが存在する。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 7-4／TR-1038 コンテンツ通信の各通信フェーズ 

発呼側 着呼側 

呼設定フェーズ 

TCP コネクション確立フェーズ 

能力通知フェーズ 
または 

能力確認フェーズ 

コンテンツ取得フェーズ 
または 

コンテンツ送信フェーズ 

TCP コネクション切断フェーズ 

呼切断フェーズ 

コンテンツリスト取得フェーズ 
または 

ジョブ生成フェーズ 

本仕様書で 

規定する部分 

アウトチャネル 

アウトチャネル 

インチャネル 
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7.4.1 呼設定フェーズ 

本フェーズは、インチャネルでのコンテンツ転送を実施するに先立ち、呼を確立することを目的とする。 

 

7.4.2 TCPコネクション確立フェーズ 

本フェーズは、コンテンツ転送に先立ち、TCP コネクションを確立することを目的とする。本プロトコルで

は、コンテンツの送信側が受信側に対して、TCP コネクションを開始するものとする。送信側は、受信側か

ら SIP/SDP によって通知された待ち受けポートに対して、TCP コネクションを張るものとする。本フェーズ

で確立した TCP コネクションの切断は、送信側が行うものとし、受信側からは行わないものとする。TCP

コネクションの確立方法については、TTC 標準 JT-Q3402 に準拠する。 

 

7.4.3 能力通知フェーズ 

本フェーズは、7.3 項の接続形態 1 において、コンテンツリスト取得フェーズに先立ち、受信側が送信側に

受信側の能力を通知することを目的とする。具体的には受信可能なコンテンツのフォーマット

（MIME-TYPE）を通知する。 

 

7.4.4 能力確認フェーズ 

本フェーズは、7.3 項の接続形態 2 と接続形態 3 において、ジョブ生成フェーズに先立ち、送信側が受信側

の能力の把握を行うことを目的とする。具体的には送信側は受信側で受信可能なコンテンツのフォーマット

（MIME-TYPE）を確認することができる。 

 

7.4.5 コンテンツリスト取得フェーズ 

本フェーズは、7.3 項の接続形態 1 において、コンテンツ取得フェーズに先立ち、受信側が送信側に送信側

に存在するコンテンツのリストを取得することを目的とする。 

 

7.4.6 ジョブ生成フェーズ 

本フェーズは、7.3 項の接続形態 2 と接続形態 3 において、コンテンツ送信フェーズに先立ち、送信側が受

信側に対して、ジョブ生成要求を行い受信側が受け入れるか否かを応答する。ジョブ生成要求には、これか

ら送信するコンテンツの情報（ファイル名、容量、MIME-TYPE等）が含まれる。 

 

7.4.7 コンテンツ取得フェーズ 

本フェーズは、7.3 項の接続形態 1 において、受信側は送信側に対してコンテンツリスト取得フェーズで取

得したコンテンツリストからコンテンツを選択し、HTTPプロトコルのGETメソッドを使い、コンテンツ取

得要求を行い、コンテンツを取得する。 

 

7.4.8 コンテンツ送信フェーズ 

本フェーズは、7.3 項の接続形態 2 と接続形態 3 において、送信側は受信側に対してHTTPプロトコルのPOST

メソッドを使い、HTTPメッセージボディに転送するファイルを含めて送信する。1 つのファイルを 1 つの

HTTPメッセージボディに含めるものとする。 

 

7.4.9 TCPコネクション切断フェーズ 

本フェーズは、コンテンツ取得フェーズ、コンテンツ送信フェーズ終了後、TCP コネクションを切断するこ
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とを目的とする。本プロトコルでは、TCP コネクションを張った機器から TCP コネクションを切断するこ

ととする。 

 

7.4.10 呼切断フェーズ 

本フェーズは、インチャネルでのコンテンツ転送終了後、呼を切断することを目的とする。 
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8 接続形態 
「7.2 アウトチャネルの接続形態」および「7.3 インチャネルの接続形態」の接続形態について説明する。 

 

8.1 アウトチャネルの接続形態 

表 7-1 の接続形態について説明する。 

SIP による呼設定、呼切断は JT-Q3402 に従い、パラメータは JF-IETF-RFC4145 に従う。 

8.1.1 項、8.1.2 項に一例を示す。 

 

8.1.1 接続形態例 1（単独呼） 

コンテンツ転送のみを行うために SIP にて TCP セッションを確立する呼の接続形態例である。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

※発呼機器からの切断を例に記述 

 

 

図 8-1／TR-1038 単独呼による発呼機器と着呼機器の通信の確立と切断の例 

 

発呼機器 SIP サーバ 着呼機器 

REGISTER 済 REGISTER 済

ダイヤル F1 SIP 接続要求<INVITE> 
with m=application 

F1 SIP 接続要求<INVITE> 
with m=application 

F3 <180 Ringing> F3 <180 Ringing> 

F4 SIP 応答<200 OK> 
with m=application 

F4 SIP 応答<200 OK> 
with m=application 

F5 SIP 確認<ACK> F5 SIP 確認<ACK> 

インチャネル通信 

F6 SIP 切断<BYE> F6 SIP 切断<BYE> 

F7 SIP 切断確認<200 OK> F7 SIP 切断確認<200 OK> 

F2 <100 Trying> F2 <100 Trying> 

通信終了 
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8.1.2 接続形態例 2（追加呼） 

メディア（音声、映像、データ等）通信中にコンテンツ転送を行うために SIP にて TCP セッションを追加す

る呼の接続形態である。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

※発呼機器からの音声、映像、データを同時に切断する例を記載 

 

 

図 8-2／TR-1038 追加呼による発呼機器と着呼機器の通信の確立と切断の例 

 

 

 

 

発呼機器 SIP サーバ 着呼機器 

F8 SIP メディア追加要求 
<reINVITE>  with m=application 

F9 SIP 応答<200 OK> 
with m=application 

F9 SIP 応答<200 OK> 
with m=application 

F10 SIP 確認<ACK> F10 SIP 確認<ACK> 

インチャネル通信 

F6 SIP 切断<BYE> F6 SIP 切断<BYE> 

F7 SIP 切断確認<200 OK> F7 SIP 切断確認<200 OK> 

メディア（音声、映像、データ等）通信確立中 

F8 SIP メディア追加要求 
<reINVITE>  with m=application 

追加操作 

通信終了 
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8.2 インチャネルの接続形態 

表 7-2 の接続形態について説明する。 

 

8.2.1 接続形態 1（発呼機器からのコンテンツ取得） 

本接続形態は、サーバとして動作する機器（着呼側）に複数のコンテンツが存在し、クライアントとして動

作する機器（発呼側）からサーバ側にある複数のコンテンツを選択して取得する。（クライアント、サーバ

動作の指定は 9.3 項を参照） 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 8-3／TR-1038 接続形態 1 

・能力通知フェーズ 

呼設定後、発呼機器は着呼機器に対し、発呼機器で受信可能なコンテンツ種別の能力を通知する。 

 

・コンテンツリスト取得フェーズ 

着呼機器に存在する複数のコンテンツを並べた 1 つのリスト（コンテンツリスト）を取得するために、発呼

機器から着呼機器に対し、コンテンツリストの要求を行い、コンテンツリストを取得する。 

 

・コンテンツ取得フェーズ 

発呼機器は、コンテンツリストから選択されたコンテンツを取得するために、HTTP GET メソッドでコンテ

ンツ要求を行い、コンテンツを取得する。複数のコンテンツを取得する場合は、HTTP GET メソッドでのコ

ンテンツ要求を取得する数だけ繰り返し行う。 

発呼機器 着呼機器 

呼設定フェーズ 

TCP セッション確立フェーズ 

能力通知フェーズ 

コンテンツリスト取得フェーズ 

コンテンツ取得フェーズ 

TCP セッション切断フェーズ 

コンテンツリスト取得要求 

コンテンツリスト取得応答 

コンテンツ取得要求 

コンテンツ取得送信 

呼切断フェーズ 

アウトチャネル 

インチャネル 

アウトチャネル 



ＴＲ－１０３８ - 28 - 

 

 

8.2.2 接続形態 2（発呼機器からのコンテンツ送信） 

本接続形態は、発呼機器をクライアントとして動作させ、着呼機器をサーバとして動作させ、発呼機器から

着呼機器にコンテンツを送信する。（クライアント、サーバ動作の指定は 9.3 項を参照） 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 8-4／TR-1038 接続形態 2 

 

・能力確認フェーズ 

呼設定後、発呼機器は着呼機器に対し、着呼機器で受信可能なコンテンツ種別を確認するための要求を行い

着呼機器の能力を確認する。 

 

・ジョブ生成フェーズ 

発呼機器は、着呼機器に対し送信するコンテンツの容量やフォーマット等の受信するための条件を通知し、

着呼機器が受信できる状態であることを確認する。 

 

・コンテンツ送信フェーズ 

発呼機器は、着呼機器に対して HTTP POST メソッドでコンテンツを送信する。複数のコンテンツを送信す

る場合は、ジョブ生成フェーズからコンテンツ送信フェーズまでを、送信するコンテンツの数だけ繰り返し

行う。 

 

発呼機器 着呼機器 

呼設定フェーズ 

TCP セッション確立フェーズ 

能力確認フェーズ 

ジョブ生成フェーズ 

コンテンツ送信フェーズ 

TCP セッション切断フェーズ 

コンテンツ送信 

呼切断フェーズ 

アウトチャネル 

インチャネル 

アウトチャネル 

ジョブ開始 

ジョブ開始応答 
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8.2.3 接続形態 3（着呼機器からのコンテンツ送信） 

本接続形態は、着呼機器をクライアントとして動作させ、発呼機器をサーバとして動作させ、着呼機器から

発呼機器にコンテンツを送信する。（クライアント、サーバ動作の指定は 9.3 項を参照） 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 8-5／TR-1038 接続形態 3 

 

・能力確認フェーズ 

呼設定後、コンテンツを送信する着呼機器はコンテンツを受信する発呼機器に対し、発呼機器で受信可能な

コンテンツ種別を確認するための要求を行い、コンテンツを受信する発呼機器の能力を確認する。 

 

・ジョブ生成フェーズ 

コンテンツを送信する着呼機器は、コンテンツを受信する発呼機器に対し送信するコンテンツの容量やフォ

ーマット等の受信するための条件を通知し、発呼機器が受信できる状態であることを確認する。 

 

・コンテンツ送信フェーズ 

コンテンツを送信する着呼機器は、コンテンツを受信する発呼機器に対して HTTP POST メソッドでコンテ

ンツを送信する。複数のコンテンツを送信する場合は、ジョブ生成フェーズからコンテンツ送信フェーズま

でを、送信するコンテンツの数だけ繰り返し行う。 

着呼機器 

呼設定フェーズ 

TCP セッション確立フェーズ 

能力確認フェーズ 

ジョブ生成フェーズ 

コンテンツ送信フェーズ 

TCP セッション切断フェーズ 

コンテンツ送信 

呼切断フェーズ 

アウトチャネル 

インチャネル 

アウトチャネル 

ジョブ開始 

ジョブ開始応答 

発呼機器 
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9 コンテンツ転送プロトコルの詳細 
本仕様書で規定するインチャネルのコンテンツ転送プロトコルは、送信側から受信側に対するリクエストと、

受信側から送信側に対するレスポンスからなる。これらのリクエストとレスポンスは SOAP メッセージを利

用し、伝送プロトコルとして HTTP プロトコルを利用する。 

 

9.1 バージョンの表記 

本プロトコルのバージョンをHTTPヘッダの "User-Agent" と "Server" に記載する。記載内容は 表 9-1 の 2

種別とする。バージョンが改版された場合は下位互換を確保する。 

HTTP ヘッダの "User-Agent" と "Server" への記載は、RFC2616 に従う。 

設定内容は、9.4.1.1 項、9.5.1.1 項を参照。 

 

表 9-1／TR-1038 記載するバージョンの種別 

種別 内容 

プロトコル種別 
本プロトコルの名称とバージョンを表す 

バージョンが改版された場合は下位互換を確保する 

機器種別 
本プロトコルを実装した機器（アプリケーション含む）の名称とバージョ

ンを表す 

 

表 9-2／TR-1038 設定する内容 

種別 項目 設定内容 

プロトコル種別 
プロトコル名 "ContentsTransfer"を設定する 

プロトコルバージョン "1.0"を設定する 

機器種別 

機器名 

（アプリケーション名） 

自由設定とする 

ただし RFC2616 に従う 

機器バージョン 

（アプリケーションバージョン） 

自由設定とする 

ただし RFC2616 に従う 

 

表 9-3／TR-1038 TR-1038 の版数とプロトコル識別の設定内容 

TR-1038 の版数 プロトコル種別 設定内容 

1.0 版 
プロトコル名 "ContentsTransfer"を設定する 

プロトコルバージョン "1.0"を設定する 
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9.2 バージョンの扱い方 

9.2.1 プロトコル識別 

プロトコル種別のバージョンが改版された場合は下位互換を確保する。 

HTTP ヘッダの "User-Agent" と "Server" に記載されているプロトコル識別のプロトコルバージョンが違う

場合は下位バーションで動作する。 

 

9.2.2 機器識別 

機器種別は、本プロトコルを実装した機器名称を自由に設定することができる。 

HTTPヘッダの "User-Agent" と "Server" に記載されている機器種別を同じと見なした場合は、送信機器と

受信機器間で利用できるSOAPアクションを独自に定義してもよい。独自に定義するSOAPメッセージの先頭

に「x-」または「X-」を記述すること。（10.1.3 項参照） 

本プロトコルで規定しているSOAPアクションに設けている "Private" タグの子要素に送信機器と受信機器

間で利用できる変数（タグ）を独自に定義してもよい。独自に定義する変数（タグ）名の先頭に「x-」また

は「X-」を記述すること。（10.1.4 項参照） 

機器名（アプリケーション名）が違った場合の動作は、独自に定義した SOAP アクションと"Private" タグの

子要素に独自に定義した変数（タグ）は無視し、本プロトコルで規定する動作を行う。 

 

9.3 発呼機器と着呼機器の動作 

発呼機器と着呼機器はそれぞれ、クライアントとして動作するか、サーバとして動作することになる。クラ

イアント、サーバのどちらで動作するかを SIP の SDP（a 行）により決定する。 

 

表 9-4／TR-1038 発呼機器と着呼機器の動作 

アウトチャネル 

発呼機器の 着呼機器の 

SDP a 行 動作 SDP a 行 動作 

a=setup:active 

に設定 

クライアントとして動作 a=setup:passive 

に設定 

サーバとして動作 

a=setup:passive 

に設定 

サーバとして動作 a=setup:active 

に設定 

クライアントとして動作 
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9.4 リクエストメッセージの生成 

9.4.1 HTTPヘッダの設定 

使用する HTTP バージョンは、持続的接続を利用するため HTTP 1.1 とする。 

 

表 9-5／TR-1038 リクエストの HTTP ヘッダ 

変数 設定内容 

Request-Line  

 Method "POST"を設定する 

 Request-URI "/soap_action"を設定する 

 HTTP-Version "HTTP/1.1"を設定する 

Request-Header  

 Accept 本ヘッダを設定する場合には"application/soap+xml"を設定する 

 Accept-Encoding 本ヘッダは設定しない 

 Expect 本ヘッダを設定する場合には“100-continue”を設定する。 

 Host 送信先の FQDN が不明の場合には、host 部に IP アドレスを設定する 

post 番号には、送信先の HTTP サーバの待ち受けポート番号を設定す

る 

 User-Agent 9.4.1.1 項を参照 

General-Header  

 Connection 続けて HTTP リクエストを送出する場合は"Keep-Alive"を設定する 

続けて HTTP リクエストを送出しない場合は" Close "を設定する 

 Date HTTP リクエストを生成した時刻を設定する 

Entity-Header  

 Content-Encoding 本ヘッダは設定しない 

 Content-Type "application/soap+xml"を設定する 

  charset "utf-8"を設定する 

  action 本パラメータは設定しない 

 Content-Length HTTP-Body のサイズ（バイト数）を設定する 
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9.4.1.1 User-Agentの記述方法 

クライアントとして動作している機器からのリクエストの HTTP ヘッダの "User-Agent" に、RFC2616 に従

いコメントとして、プロトコル種別（プロトコル名、プロトコルバージョン）および、機器種別（機器名（ア

プリケーション名）、機器バージョン（アプリケーションバージョン））を記載する。 

機器種別を複数記述する場合はカンマで区切って記述する。 

リクエストの HTTP ヘッダの "User-Agent" と、レスポンスの HTTP ヘッダの "Server" に記載されている機

器種別を同じと見なした場合は、送信機器と受信機器間で利用できる SOAP アクションを独自に定義しても

よい。 

 

■記述方法（機器種別が 1 つの場合） 

 

User-Agent:<SP><プロトコル名>/<プロトコルバージョン><SP>(<機器名>;<SP><機器バージョン>;) 

 

表 9-6／TR-1038 User-Agent の設定内容 

項目 設定内容 

<SP> "%x20" （半角スペース） 

<プロトコル名> 表 9-3 に従い設定する 

<プロトコルバージョン> 表 9-3 に従い設定する 

<機器名> 半角英数字で設定する 

<機器バージョン> 半角英数字で設定する 

 

■記述方法（機器種別が複数の場合）機器種別が 2 つを例に記述 

 

User-Agent:<SP><プロトコル名>/<プロトコルバージョン><SP>(<機器名>;<SP><機器バージョン>;<SP><

機器名>;<SP><機器バージョン>;) 

 

 

 

 

 

 

 

 

 

 

 

図 9-1／TR-1038 HTTP ヘッダ「User-Agent」の記述 

 

■記述例（機器種別が 1 つの場合） 

 

User-Agent: ContentsTransfer/1.0 (ContentsTransferApplication; 1.0;) 

 

■記述例（機器種別が複数の場合）機器種別が 2 つを例に記述 

 

User-Agent: ContentsTransfer/1.0 (ContentsTransferApplication; 1.0;, ContentsTransferEquipment; 1.0;) 
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9.4.1.2 暫定応答要求 

本プロトコルはHTTP1.1 を使用しているため、クライアントとして動作している機器は、リクエストのHTTP

ヘッダに「Expect: 100-Continue」を付加してもよい。サーバとして動作している機器は、「Expect: 100-Continue」

を受け取った場合は「HTTP/1.1 100 Continue」を返送しなければならない。シーケンスは 9.7 項を参照のこ

と。 
さらに、セッション持続要求に関するSOAPアクション（10.2.8 項、10.3.7 項）を実施すること。 
 

9.4.2 SOAPメッセージの設定 

使用する SOAP バージョンは、SOAP 1.2 とする。 

以降特に断りがない場合は、SOAP メッセージ内で使用できる文字のエンコーディングは UTF-8 とする。 

 

表 9-7／TR-1038 リクエストの SOAP メッセージ 

設定内容 備考 

<?xml version="1.0" encoding=” UTF-8” ?>  

<env:Envelope 

xmlns:env="http://www.w3.org/2003/05/soap-envelope"  

xmlns:ct="http://www.ttc.or.jp/mmsys/ct"> 

 

 <env:Body>  

  <request-method-name 

env:encodingStyle="http://www.w3.org/2003/05/soap-envelope" 

xmlns:ct="http://www.ttc.or.jp/mmsys/ct"> 

request-method-name の部分に

リクエストメソッド名を設定

する 

  <（引数）>  

 

9.4.2.1 ネームスペース 

本プロトコルで定義する XML 要素のネームスペースは 

 

本編 :  http://www.ttc.or.jp/mmsys/ct 

AnnexA :  http://www.ttc.or.jp/mmsys/ct/cta 

AnnexB :  http://www.ttc.or.jp/mmsys/ct/ctb 

 

とする。お互いに参照して利用して構わない。 
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9.5 レスポンスメッセージの生成 

9.5.1 HTTPヘッダの設定 

使用する HTTP バージョンは、持続的接続を利用するため HTTP 1.1 とする。 

 

表 9-8／TR-1038 レスポンスの HTTP ヘッダ 

変数 設定内容 

Status-Line  

 HTTP-Version "HTTP/1.1"を設定する 

 Status-Code  

 Reason-Phrase  

Request-Header  

 Server 9.5.1.1 項を参照 

General-Header  

 Connection "Keep-Alive"を設定する 

 Date HTTP レスポンスを生成した時刻を設定する 

Entity-Header  

 Content-Encoding 本ヘッダは設定しない 

 Content-Type "application/soap+xml"を設定する 

  charset "utf-8"を設定する 

  action 本パラメータは設定しない 

 Content-Length HTTP-Body のサイズ（バイト数）を設定する 

 

9.5.1.1 Serverの記述方法 

サーバとして動作している機器からのレスポンスのHTTPヘッダの "Server" に、RFC2616 に従いコメントと

してプロトコル識別（プロトコル名、プロトコルバージョン）および、機器種別（機器名（アプリケーショ

ン名）、機器バージョン（アプリケーションバージョン））、TCPセッションタイマー値（9.5.1.2 項を参照）を

記載する。機器種別を複数記述する場合はカンマで区切って記述する。 

リクエストの HTTP ヘッダの "User-Agent" と、レスポンスの HTTP ヘッダの "Server" に記載されている機

器種別を同じと見なした場合は、送信機器と受信機器間で利用できる SOAP アクションを独自に定義しても

よい。 

 

■記述方法（機器種別が 1 つの場合） 

 

Server:<SP><プロトコル名>/<プロトコルバージョン><SP>(<機器名>;<SP><機器バージョン>;)<SP>x:<TCP

セッションタイマー値（秒）>; 
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表 9-9／TR-1038 User-Agent の設定内容 

項目 設定内容 

<SP> "%x20" （半角スペース） 

<プロトコル名> 表 9-3 に従い設定する 

<プロトコルバージョン> 表 9-3 に従い設定する 

<機器名> 半角英数字で設定する 

<機器バージョン> 半角英数字で設定する 

<TCP セッションタイマー値（秒）> 半角数字で設定する 

 

■記述方法（機器種別が複数の場合）機器種別が 2 つを例に記述 

 

Server:<SP><プロトコル名>/<プロトコルバージョン><SP>(<機器名>;<SP><機器バージョン>;<SP><機器

名>;<SP><機器バージョン>;)<SP>x:< TCP セッションタイマー値（秒）>; 

 

 

 

 

 

 

 

 

 

図 9-2／TR-1038 HTTP ヘッダ「Server」の記述 

 

 

9.5.1.2 TCPセッションタイマー 

9.5.1.1 項にて設定したTCPセッションタイマー値を経過するとサーバとして動作している機器からTCPセッ

ションが切断される。例えば、 "150" と設定した場合、150 秒でTCPセッションが切れる。TCPのセッショ

ンを継続する場合は、TCPセッションタイマー値を経過する前に、クライアントとして動作している機器か

らサーバとして動作している機器にセッションを持続させるためのアクション（10.2.8 項、10.3.7 項参照）

を行う。 

サーバとして動作している機器から HTTP ヘッダの "Server" で通知される TCP セッションタイマー値は 

HTTP ヘッダの "Server" が送信された時点でリフレッシュされる。 

クライアントとして動作している機器は、最新のサーバとして動作している機器から HTTP ヘッダの 

"Server" で通知される TCP セッションタイマー値で TCP セッションタイマーを管理する。 

 

9.5.1.3 暫定応答 

クライアントとして動作している機器からのリクエストのHTTPヘッダに「Expect: 100-continue」が付与され

ている場合、サーバとして動作している機器は「HTTP/1.1 100 Continue」のレスポンスを返すこと。シーケ

ンスは 9.7 項を参照のこと。 
さらに、セッション持続要求に関するSOAPアクション（10.2.8 項、10.3.7 項）を実施すること。 

■記述例（機器種別が 1 つの場合） 

 

Server: ContentsTransfer/1.0 (ContentsTransferApplication; 1.0;) x:150; 

 

■記述例（機器種別が複数の場合）機器種別が 2 つを例に記述 

 

Server: ContentsTransfer/1.0 (ContentsTransferApplication; 1.0;, ContentsTransferEquipment; 1.0;) x:150; 
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9.5.2 SOAPメッセージの設定 

使用する SOAP バージョンは、SOAP 1.2 とする。 

以降特に断りがない場合は、SOAP メッセージ内で使用できる文字のエンコーディングは UTF-8 とする。 

 

表 9-10／TR-1038 レスポンスの SOAP メッセージ 

設定内容 備考 

<?xml version="1.0" encoding=”UTF-8” ?>  

<env:Envelope 

xmlns:env="http://www.w3.org/2003/05/soap-envelope"  

xmlns:ct="http://www.ttc.or.jp/mmsys/ct"> 

 

 <env:Body>  

  <request-method-name 

env:encodingStyle="http://www.w3.org/2003/05/soap-envelope" 

xmlns:ct="http://www.ttc.or.jp/mmsys/ct"> 

request-method-name の部分に

リクエストメソッド名を設定

する 

  <（引数）>  

 

9.5.2.1 ネームスペース 

本プロトコルで定義する XML 要素のネームスペースは 

 

本編 :  http://www.ttc.or.jp/mmsys/ct 

AnnexA :  http://www.ttc.or.jp/mmsys/ct/cta 

AnnexB :  http://www.ttc.or.jp/mmsys/ct/ctb 

 

とする。お互いに参照して利用して構わない。 
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9.6 SOAPアクションの要求と取得 

リクエストの HTTP ヘッダの "User-Agent" と、レスポンスの HTTP ヘッダの "Server" に記載されている機

器種別を同じと見なした場合は、送信機器と受信機器間で利用できる SOAP アクションを定義して使用して

もよいが、今後、SOAP アクションが追加されたとき、送信機器と受信機器間で追加された SOAP アクショ

ンを把握するために、SOAP アクションリスト要求を行い、サーバとして動作する機器の SOAP アクション

を把握する手段を設ける。 

HTTP GET メソッドによる「/soap_action」の送信を、SOAP アクションリストの要求とする。 

 

 

 

 

 

 

 

 

 

図 9-3／TR-1038 SOAP アクションリストの要求方法 
 

9.7 接続形態のシーケンス 

本仕様書で規定する SOAP アクションを使用したインチャネルのコンテンツ転送プロトコルには 3 つの接続

形態がありそのシーケンスを記述する。 

 

インチャネル接続形態 1 : 発呼機器からのコンテンツ取得 

インチャネル接続形態 2 : 発呼機器からのコンテンツ送信 

インチャネル接続形態 3 : 着呼機器からのコンテンツ送信 

 

 

着呼機器 

着呼機器が実装している 
SOAP アクションリストの要求 

発呼機器 

SOAP アクションリスト 
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9.7.1 発呼機器からのコンテンツ取得 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 9-4／TR-1038 インチャネル接続形態 1:発呼機器からのコンテンツ取得のシーケンス図 

 

発呼機器 SIP サーバ 着呼機器 

呼設定フェーズ 

TCP セッション確立フェーズ 

能力通知フェーズ 

F13 能力通知<HTTP POST> 

F14 能力通知応答<HTTP 200 OK> 

コンテンツリスト取得フェーズ 

コンテンツ取得フェーズ 

TCP セッション切断フェーズ 

F17 コンテンツリスト取得要求<HTTP POST> 

F18 コンテンツリスト取得応答<HTTP 200 OK> 

F21 コンテンツ 1 取得要求<HTTP GET> 

F22 コンテンツ 1 取得送信<HTTP 200 OK> 

呼切断フェーズ 

F25 コンテンツ n 取得要求<HTTP GET> 

F26 コンテンツ n 取得送信<HTTP 200 OK> 

アウト 
チャネル 

イン 
チャネル 

アウト 
チャネル 

F11 暫定応答要求<Expect: 100-continue> 

F12 暫定応答< HTTP/1.1 100 Continue > 

F15 暫定応答要求<Expect: 100-continue> 

F16 暫定応答< HTTP/1.1 100 Continue > 

F19 暫定応答要求<Expect: 100-continue> 

F20 暫定応答< HTTP/1.1 100 Continue > 

F23 暫定応答要求<Expect: 100-continue> 

F24 暫定応答< HTTP/1.1 100 Continue > 
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9.7.2 発呼機器からのコンテンツ送信 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 9-5／TR-1038 インチャネル接続形態 2:発呼機器からのコンテンツ送信のシーケンス図 

SIP サーバ 着呼機器 

呼設定フェーズ 

TCP セッション確立フェーズ 

能力確認フェーズ 

F29 能力確認要求<HTTP POST> 

F30 能力確認応答<HTTP 200 OK> 

ジョブ生成フェーズ 

コンテンツ送信フェーズ 

TCP セッション切断フェーズ 

F33 ジョブ開始要求<HTTP POST> 

F34 ジョブ開始応答<HTTP 200 OK> 

F37 コンテンツ 1 送信<HTTP POST> 

F38 コンテンツ 1 送信応答<HTTP 200 OK> 

呼切断フェーズ 

アウト 
チャネル 

イン 
チャネル 

アウト 
チャネル 

発呼機器 

ジョブ生成フェーズ 

コンテンツ送信フェーズ 

F41 ジョブ開始要求<HTTP POST> 

F42 ジョブ開始応答<HTTP 200 OK> 

F45 コンテンツ n 送信<HTTP POST> 

F46 コンテンツ n 送信応答<HTTP 200 OK> 

F27 暫定応答要求<Expect: 100-Continue> 

F28 暫定応答< HTTP/1.1 100 Continue > 

F31 暫定応答要求<Expect: 100-Continue> 

F32 暫定応答< HTTP/1.1 100 Continue > 

F35 暫定応答要求<Expect: 100-Continue> 

F36 暫定応答< HTTP/1.1 100 Continue > 

F39 暫定応答要求<Expect: 100-Continue> 

F40 暫定応答< HTTP/1.1 100 Continue > 

F43 暫定応答要求<Expect: 100-Continue> 

F44 暫定応答< HTTP/1.1 100 Continue > 
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9.7.3 着呼機器からのコンテンツ送信 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 9-6／TR-1038 インチャネル接続形態 3:着呼機器からのコンテンツ送信のシーケンス図 
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F29 能力確認要求<HTTP POST> 

F30 能力確認応答<HTTP 200 OK> 

ジョブ生成フェーズ 

コンテンツ送信フェーズ 

TCP セッション切断フェーズ 

F33 ジョブ開始要求<HTTP POST> 

F34 ジョブ開始応答<HTTP 200 OK> 

F37 コンテンツ 1 送信<HTTP POST> 

F38 コンテンツ 1 送信応答<HTTP 200 OK> 

呼切断フェーズ 

アウト 
チャネル 
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チャネル 

アウト 
チャネル 

発呼機器 

ジョブ生成フェーズ 

コンテンツ送信フェーズ 

F41 ジョブ開始要求<HTTP POST> 

F42 ジョブ開始応答<HTTP 200 OK> 

F45 コンテンツ n 送信<HTTP POST> 

F46 コンテンツ n 送信応答<HTTP 200 OK> 

F27 暫定応答要求<Expect: 100-Continue> 

F28 暫定応答< HTTP/1.1 100 Continue > 

F31 暫定応答要求<Expect: 100-Continue> 

F32 暫定応答< HTTP/1.1 100 Continue > 

F35 暫定応答要求<Expect: 100-Continue> 

F36 暫定応答< HTTP/1.1 100 Continue > 

F39 暫定応答要求<Expect: 100-Continue> 

F40 暫定応答< HTTP/1.1 100 Continue > 

F43 暫定応答要求<Expect: 100-Continue> 

F44 暫定応答< HTTP/1.1 100 Continue > 
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10 SOAPアクションの規定 
10.1 注意事項 

10.1.1 変数（タグ）のM/Oの扱い 

各 SOAP メッセージの変数（タグ）には「M/O」が規定されており、「M」は Mandatory の略であり必須タグ、

「O」は Option の略でありオプションタグである。 

オプションタグが設定された SOAP アクションを受信した場合、受信した機器で解釈できるオプションタグ

である場合は、受信した機器はオプションタグに設定された内容で動作させ、解釈できなければ、無視する。 

 

10.1.2 値の無い変数（タグ）の扱い 

「M」の必須タグは、そのタグの値が無い場合であっても、SOAP メッセージには値の無いタグ（空タグ）

を記載する。 

「O」のオプションタグは、そのタグの値が無い場合は、SOAP メッセージには記載を省略しても構わない。 

 

10.1.3 SOAPアクションの独自拡張 

リクエストの HTTP ヘッダの "User-Agent" と、レスポンスの HTTP ヘッダの "Server" に記載されている機

器種別が同じであることを前提に、送信機器と受信機器間で利用できる SOAP アクションを独自に定義して

もよい。独自に定義する SOAP メッセージの先頭に「x-」または「X-」を記述すること。 

 

10.1.4 タグの独自拡張 

本プロトコルで規定している SOAP アクションには、変数（タグ）に "Private" タグを設けている。 

リクエストの HTTP ヘッダの "User-Agent" と、レスポンスの HTTP ヘッダの "Server" に記載されている機

器種別が同じであることを前提に、この "Private" タグの子要素に、送信機器と受信機器間で利用できる変

数（タグ）を独自に定義してもよい。独自に定義する変数（タグ）名の先頭に「x-」または「X-」を記述す

ること。 
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10.2 リクエストメッセージ 

10.2.1  能力通知（InformCapability） 

コンテンツ取得において、クライアントとして動作している機器がサーバとして動作している機器に対して、

クライアントとして動作している機器で扱うことができるコンテンツの種類を通知する。 

 

表 10-1／TR-1038 能力通知（InformCapability） 

変数（タグ） M/O 内容 

<ct:InformCapability> M － 

 <ct:SupportedFormats> M サポートしている MIME-Type すべてをカンマで区切っ

て設定する 

 <Private> O 独自拡張用とする 

※「M」=必須、「O」=オプション 

 

10.2.1.1 <ct:SupportedFormats> 

原則 IANA 登録（http://www.iana.org/assignments/media-types/を参照）された MIME-Type 表記で、応

答可能な 10-2 すべての能力をカンマで区切った CSV リスト形式で記載する。但し、下記の記述ルールとす

る。 

 

(1) 正規表現は「*」1 文字だけ対応する（例:「ima*」等には対応しない） 

(2) 「*」（アスタリスク）は「全て」を意味する 

(3) 複数のフォーマットの設定は、「,」（カンマ）区切りで記述する 

(4) 先に記載したものを優先する 

(5) 「!」（エクスクラメーションマーク）は、「否定（NOT）」とする 

(6) 「!」は MIME-Type の先頭に記載することとする 

 

例: 

全てのファイルフォーマットに対応する場合  ⇒ */* 

PNG 形式の画像フォーマットに対応していない場合  ⇒ !image/png  

画像は全て対応しているが、動画は未対応の場合  ⇒ image/*,!video/* 

 

10.2.1.2 <Private> 

子要素に独自タグを設定できる。（10.1.4 項参照） 
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10.2.2  能力確認要求（GetCapability） 

クライアントとして動作している機器からサーバとして動作している機器に対して、コンテンツを送信する

際に、サーバとして動作している機器で扱うことができるコンテンツの種類を確認する。 

 

表 10-3／TR-1038 能力確認要求（GetCapability） 

変数 M/O 内容 

<ct:GetCapability> M － 

 <Options> O 付属資料 Annex で定義する 

 <Private> O 独自拡張用とする 

※「M」=必須、「O」=オプション 

 

10.2.2.1 <Options> 

付属資料 Annex で定義する。 
 

10.2.2.2 <Private> 
子要素に独自タグを設定できる。（10.1.4 項参照） 
 

10.2.3  コンテンツリスト取得要求（GetContentsList） 

クライアントとして動作している機器からサーバとして動作している機器に対して、サーバとして動作して

いる機器に存在するコンテンツリストを取得する。 

 

表 10-4／TR-1038 コンテンツリスト取得要求（GetContentsList） 

変数 M/O 内容 

<ct:GetContentsList> M － 

 <Private> O 独自拡張用とする 

※「M」=必須、「O」=オプション 

 

10.2.3.1 <Private> 

子要素に独自タグを設定できる。（10.1.4 項参照） 
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10.2.4  ジョブ開始要求（CreateJob） 

クライアントとして動作している機器からサーバとして動作している機器に対して、コンテンツを送信する

際に、送付するコンテンツの容量やフォーマット等の受信するための条件を通知する。 

 

表 10-5／TR-1038 ジョブ開始要求（CreateJob） 

変数 M/O 内容 

<ct:CreateJob> M － 

 <ct:ContentName> M 送信するファイル名を設定する 

 <ct:ContentSize> M 送信するファイルのサイズをバイト数（Integer 64 bit の

範囲で半角数）で設定する 

 <ct:Format> M 送信するファイルの MIME-Type を設定する 

 <Options> O 付属資料 Annex で定義する 

 <Private> O 独自拡張用とする 

※「M」=必須、「O」=オプション 

 

10.2.4.1 <ct:Format> 

原則 IANA 登録（http://www.iana.org/assignments/media-types/を参照）された MIME-Type を設定する。 

 

10.2.4.2 <Options> 

付属資料 Annex で定義する。 
 

10.2.4.3 <Private> 
子要素に独自タグを設定できる。（10.1.4 項参照） 
 

10.2.5  コンテンツ取得要求 

接続形態 1 においてコンテンツを取得する際に、コンテンツリスト取得応答（GetContentsListResponse）の

<ct:Path>、<ct:Name>に設定された内容のコンテンツを取得するために、HTTP GET メソッドでコンテンツ

リスト取得応答（GetContentsListResponse）の<ct:Path>、<ct:Name>に設定されたコンテンツの取得要求を行

う。このためコンテンツ取得要求を行うために新たに SOAP アクションは規定しない。複数のコンテンツを

取得する場合は、HTTP GET メソッドでのコンテンツ取得要求を取得する数だけ繰り返し行う。 

 

10.2.6  コンテンツ送信 
接続形態 2、接続形態 3 においてジョブ開始（CreateJob）を行った後に行う、クライアントとして動作して

いる機器からサーバとして動作している機器に対してのコンテンツ送信は、HTTP POSTメソッドでRFC1867
および RFC2388 に従いコンテンツを送信する。このためコンテンツ送信を行うために新たに SOAP アクシ

ョンは規定しない。 
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10.2.7  コンテンツ送信終了（EndSendContent） 

コンテンツ送信（10.2.6 項）によるコンテンツの送信が終了した際、明示的に終了したことを通知したい場

合に、コンテンツ送信終了を行ってもよい。 

または、リクエストメッセージの HTTP ヘッダの " Connection " に "Close" を設定する。 

 

表 10-6／TR-1038 コンテンツ送信終了（EndSendContent） 

変数 M/O 内容 

<ct:EndSendContent> M － 

 <Private> O 独自拡張用とする 

※「M」=必須、「O」=オプション 

 

10.2.7.1 <Private> 
子要素に独自タグを設定できる。（10.1.4 項参照） 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 10-1／TR-1038 コンテンツ送信終了のシーケンス例 

着呼機器 

（サーバ機能） 

発呼機器 

（クライアント機能） 

TCP セッション切断フェーズ 

呼切断フェーズ 

F49 コンテンツ送信終了<HTTP POST> 

F50 コンテンツ送信終了応答<HTTP 200 OK> 

F47 暫定応答要求<Expect: 100-Continue> 

F48 暫定応答< HTTP/1.1 100 Continue > 

コンテンツ送信フェーズ 
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10.2.8  セッション持続要求（ContinueSession） 

ユーザによるコンテンツ選択操作時にファイル送信の間隔が開き、SOAP メッセージ通信の間隔が開き、

HTTP ヘッダ "Server" にて通知された TCP セッションタイマー値を越える場合、インチャネルの TCP セッ

ションを持続させるため、TCP セッションタイマー値を越える前に、本セッション持続要求を行い TCP セ

ッションの持続的接続を維持する。 

 

表 10-7／TR-1038 セッション持続要求（ContinueSession） 

変数 M/O 内容 

<ct:ContinueSession> M － 

 <Private> O 独自拡張用とする 

※「M」=必須、「O」=オプション 

 

10.2.8.1 <Private> 
子要素に独自タグを設定できる。（10.1.4 項参照） 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 10-2／TR-1038 セッション持続のシーケンス例 

 

着呼機器 

（サーバ機能） 

発呼機器 

（クライアント機能）

TCP セッション切断フェーズ 

呼切断フェーズ 

F53 セッション持続要求<HTTP POST> 

F54 セッション持続要求応答<HTTP 200 OK> 

F51 暫定応答要求<Expect: 100-Continue> 

F52 暫定応答< HTTP/1.1 100 Continue > 

コンテンツ送信フェーズ 

コンテンツ送信フェーズ 

タイマ更新 
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10.3 レスポンスメッセージ 

10.3.1  能力通知応答（InformCapabilityResponse） 

コンテンツ取得において、能力通知（InformCapability）に対して、サーバとして動作している機器がクライ

アントとして動作している機器に対して応答する。 

 

表 10-8／TR-1038 能力通知応答（InformCapabilityResponse） 

変数 M/O 内容 

<ct:InformCapabilityResponse> M － 

 <Private> O 独自拡張用とする 

※「M」=必須、「O」=オプション 

 

10.3.1.1 <Private> 

子要素に独自タグを設定できる。（10.1.4 項参照） 
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10.3.2  能力確認応答（GetCapabilityResponse） 

コンテンツ送信において、能力確認要求（GetCapability）に対して、サーバとして動作している機器からク

ライアントとして動作している機器に対して、コンテンツを送信する際に、サーバとして動作している機器

で扱うことができるコンテンツの種類を確認する。 

 

表 10-9／TR-1038 能力確認応答（GetCapabilityResponse） 

変数 M/O 内容 

<ct:GetCapabilityResponse> M － 

 <ct:SupportedFormats> M サポートしている MIME-Type すべてをカンマで区切っ

て設定する 

 <Options> O 付属資料 Annex で定義する 

 <Private> O 独自拡張用とする 

※「M」=必須、「O」=オプション 

 

10.3.2.1 <ct:SupportedFormats> 

原則 IANA 登録（http://www.iana.org/assignments/media-types/を参照）された MIME-Type 表記で、応答可能な

すべての能力をカンマで区切った CSV リスト形式で記載する。但し、下記の記述ルールとする。 

 

(1) 正規表現は「*」1 文字だけ対応する（例:「ima*」等には対応しない） 

(2) 「*」（アスタリスク）は「全て」を意味する 

(3) 複数のフォーマットの設定は、「,」（カンマ）区切りで記述する 

(4) 先に記載したものを優先する 

(5) 「!」（エクスクラメーションマーク）は、「否定（NOT）」とする 

(6) 「!」は MIME-Type の先頭に記載することとする 

 

例: 

全てのファイルフォーマットに対応する場合  ⇒ */* 

PNG 形式の画像フォーマットに対応していない場合  ⇒ !image/png  

画像は全て対応しているが、動画は未対応の場合  ⇒ image/*,!video/* 

 

10.3.2.2 <Options> 

付属資料 Annex で定義する。 

 

10.3.2.3 <Private> 

子要素に独自タグを設定できる。（10.1.4 項参照） 
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10.3.3  コンテンツリスト取得応答（GetContentsListResponse） 

コンテンツリスト取得要求（GetContentsList）に対して、サーバとして動作している機器からクライアント

として動作している機器に対して、サーバとして動作している機器に存在するコンテンツリストを送信する。 

 

表 10-10／TR-1038 コンテンツリスト取得応答（GetContentsListResponse） 

変数 M/O 内容 

<ct:GetContentsListResponse> M － 

 <ct:ContentsList> M － 

  <ct:Content> M － 

   <ct:Path> M コンテンツが存在するパスを設定する 

   <ct:Name> M ファイル名を設定する 

   <ct:Size> M ファイルのサイズをバイト数（Integer 64 bit の範囲で半

角数）で設定する 

   <ct:Format> M 送信するファイルの MIME-Type を設定する 

   <ct:Title> O ファイルタイトルを設定する 

   <ct:Description> O コンテンツ説明文を設定する 

 <Private> O 独自拡張用とする 

※「M」=必須、「O」=オプション 

 

10.3.3.1 <ct:ContentsList> 

コンテンツリストを示す。子要素を設定する。 

 

10.3.3.2 <ct:Content> 

リスト化するコンテンツを示す。子要素を設定する。 

<ct:ContentsList>の子要素として複数設定することを可とする。 

 

10.3.3.3 <ct:Format> 

コンテンツファイルの MIME-Type を設定する。 

原則 IANA 登録（http://www.iana.org/assignments/media-types/を参照）された MIME-Type を設定する。 

 

10.3.3.4 <ct:Title> 

コンテンツファイルのタイトルを設定する。ファイルのタイトルを設定しないことも可とする。 

コンテンツファイルのタイトルを設定しない、つまり<ct:Title> の値が空きである場合でも必ず<ct:Content>

に空タグを設定する。（10.1.2 項参照） 
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10.3.3.5 <ct:Description> 

コンテンツ説明文を設定する。コンテンツ説明文を設定しないことも可とする。 

コンテンツ説明文を設定しない、つまり<ct:Title> の値が空きである場合でも必ず<ct:Content>に空タグを設

定する。（10.1.2 項参照） 

 

10.3.3.6 <Private> 

子要素に独自タグを設定できる。（10.1.4 項参照） 

 

10.3.4  ジョブ開始応答（CreateJobResponse） 

ジョブ開始要求（CreateJob）に対して、サーバとして動作している機器からクライアントとして動作してい

る機器に対して、コンテンツを受信する際に、JobID や送信先のパスを通知する。 

 

表 10-11／TR-1038 ジョブ開始応答（CreateJobResponse） 

変数 M/O 内容 

<ct:CreateJobResponse> M － 

 <ct:JobID> M ジョブ識別子（Integer 32 bit の範囲で半角数）を設定す

る 

 <ct:Path> M ファイル送信の HTTP POST メソッドの宛先 Request-URI

を設定する 

 <Options> O 付属資料 Annex で定義する 

 <Private> O 独自拡張用とする 

※「M」=必須、「O」=オプション 

 

10.3.4.1 <ct:JobID > 

<ct:JobID>タグは、ジョブ開始要求（CreateJob）に対する応答を行う際に通知する。 

ジョブ開始要求で通知されるファイル容量やファイルフォーマット等の条件で受信可能な場合、ジョブ開始

要求に対する応答時に 

<ct:JobID>タグにジョブ開始要求（CreateJob）で通知された jobID を設定して通知する。 

 

ジョブ開始要求で通知される条件で受信できない場合、JobID には下記の ID（エラーコード）を通知して受

信を拒否する。 

 

-1 ＝ 不正なファイル名による受信拒否 

-2 ＝ 容量オーバによる受信拒否 

-3 ＝ 未対応ファイルフォーマットによる受信拒否 

-4 ＝ <Options>、<Private>に理解不能な値があり受信拒否したい場合 
（受信拒否せず無視する場合は、-4 を通知せず JodID を設定する） 

 

10.3.4.2 <Options> 

付属資料 Annex で定義する。 
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10.3.4.3 <Private> 

子要素に独自タグを設定できる。（10.1.4 項参照） 
 

10.3.5 コンテンツ取得送信 

接続形態 1 において、HTTP GET メソッドのコンテンツ取得要求に対して、HTTP1.1 200OK に要求されたコ

ンテンツを送信する。SOAP アクションは規定しない。 

 

10.3.6 コンテンツ送信終了応答 

コンテンツ送信終了（EndSendContent）に対して、返送する。 

シーケンス図は図 10-1／TR-1038 を参照。 

 

表 10-12／TR-1038 コンテンツ送信終了応答（EndSendContentResponse） 

変数 M/O 内容 

<ct:EndSendContentResponse> M － 

 <Private> O 独自拡張用とする 

※「M」=必須、「O」=オプション 

 

10.3.6.1 <Private> 

子要素に独自タグを設定できる。（10.1.4 項参照） 
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10.3.7  セッション持続応答（ContinueSessionResponse） 

セッション持続（ContinueSession）に対して、サーバとして動作している機器からクライアントとして動作

している機器に対して、TCP セッションを持続する新たな TCP セッションタイマー値を通知する。 

TCPセッションタイマー値の通知は、HTTPヘッダの "Server" に記載する。（9.5.1.1 項参照） 

シーケンス図は図 10-2 を参照。 

 

表 10-13／TR-1038 セッション持続応答（ContinueSessionResponse） 

変数 M/O 内容 

<ct:ContinueSessionResponse> M － 

 <Private> O 独自拡張用とする 

※「M」=必須、「O」=オプション 

 

10.3.7.1 <Private> 

子要素に独自タグを設定できる。（10.1.4 項参照） 
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11 準正常系、異常系の動作規定 
11.1 準正常系の動作規定 

 

表 11-1／TR-1038 準正常系の動作規定 

項番 状況 対応策 

1 HTTP ヘッダの "User-Agent" と "Server" に

記載されているプロトコル識別のプロトコ

ルバージョンが違った場合 

・下位バーションで動作する 

・上位バージョンを実装している機器は下位互換

を確保する 

2 HTTP ヘッダの "User-Agent" と "Server" に

記載されている機器名（アプリケーション

名）が違った場合 

・独自に定義したSOAPアクションと"Private" タ

グの子要素に定義した変数（タグ）は無視し、本

プロトコルで規定する動作を行う（9.2 項参照）

3 HTTP ヘッダの "Server" で通知される TCP

セッションタイマー値が無かった場合 

・TCP セッションは切断されないとして動作する

4 コンテンツ送信側機器がサポートするファ

イルフォーマットが、コンテンツ受信側機器

で扱えない場合 

・発呼機器からの TCP セッションの切断および

呼の切断を実施する 

5 SOAP メッセージの「Options」、「Private」タ

グの内容が理解できない場合 

・無視する 

・ 拒 否 し た い 場 合 は 、 ジ ョ ブ 開 始 応 答

（CreateJobResponse）の<ct:JobID>にエラーコー

ドを設定して通知する（10.3.4 項参照） 

・「Private」タグの子要素の設定はコンテンツ送

信側機器とコンテンツ受信側機器で利用できる

ように設定する（10.1.4 項参照） 

6 コンテンツ受信側機器で受信したくないフ

ァイルフォーマットを指定したい場合 

・能力通知要求（InformCapability）もしくは能力

確 認 応 答 （ GetCapabilityResponse ） の

<ct:SupportedFormats>の設定に「!」を設定して受

信拒否したい旨を通知する（10.2.1 項、10.3.2 項

参照） 

7 コンテンツ送信を開始する際、ファイル容量

オーバ等の何らかの原因でコンテンツ受信

側機器が受信拒否したい場合 

・ ジ ョ ブ 開 始 応 答 （ CreateJobResponse ） の

<ct:JobID>にエラーコードを設定して通知する

（10.3.4 項参照） 

8 コンテンツ送信中に受信側の機器のメモリ

不足等によりコンテンツ送信を待たせたい

場合 

・受信側の機器は送信側の機器に TCP の ACK を

返さない 

9 サーバとして動作している機器が、「Expect: 

100-continue」が付与されていないリクエスト

を受信した場合 

・ボディ部も含まれていると想定し、ボディ部の

受信が完了した後、200OK を返却する 

10 サーバとして動作している機器が、「Expect: 

100-contine」が付与されているボディ部も含

まれたリクエストを受信した場合  

・ボディ部の受信が完了した後、200OK を返却す

る 

11 サーバとして動作している機器が、「Expect: 

100-contine」が付与されているヘッダ部のみ

・HTTP ステータスコードでエラーレスポンスを

返却後、呼を切断する 
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記載されたリクエストを受信し、「HTTP/1.1 

100 Continue」を返信したが、ボディ部を一

定時間経過しても受信しない場合 

12 クライアントとして動作している機器が、

「Expect: 100-contine」を送信したが、サーバ

として動作している機器からのレスポンス

が無い場合 

・レスポンス「HTTP/1.1 100 Continue」が返送さ

れなくても一定時間経過すればボディ部の送出

を開始する 

13 コンテンツ送信終了（EndSendContent）が通

知されずに切断された場合 

・コンテンツは全て送信されたとして終了する 

 
 

11.2 異常系の動作規定 

 

表 11-2／TR-1038 異常系の動作規定 

項番 状況 対応策 

1 コンテンツ送信側機器からの能力確認要

求（GetCapability）に<ct:SupportedFormats>

が設定されていた場合 

・無視する 

・「Private」タグの子要素を利用して能力を通知す

る場合はコンテンツ送信側機器とコンテンツ受信

側機器で利用できるように設定する（10.1.4 項参照）

2 コンテンツ受信側で受信した SOAP アク

ションに、規定にないタグが記載されてい

た場合 

・無視する 

・HTTP ステータスコードでエラーレスポンスを返

信する 

・「Private」タグの子要素にタグを設定する場合は

コンテンツ送信側機器とコンテンツ受信側機器で

利用できるように設定する（10.1.4 項参照） 

3 SOAP リクエストメッセージを送信した

が、SOAP レスポンスメッセージが返って

こない場合 

・30 秒経過しても返ってこない場合は、何らかの原

因で相手機器が居なくなったとして終了する。 

4 予期せぬ FIN や RST などでコンテンツフ

ァイルの送受信中に TCP セッションが切

断された場合 

・TCP の再接続は行わず、シーケンスは終了したと

し、呼を切断する 

・再度、コンテンツ送信を実施する場合は、発呼か

ら開始する 

 

 

12 おわりに 
本技術レポートでは、NGN 環境下の SOAP/HTTP を利用したコンテンツ転送システムについて、コンテンツ

を送信機器から受信機器に送る基本的仕様の検討に注力し記述してきた。今後、2 つの機器間で双方向にコ

ンテンツを送り合う方法や、機器間でリアルタイムに協調作業ができる方法、高度な制御・表示信号の扱い、

AnnexA、AnnexB の充実・高度化、AnnexC、AnnexD の規定、などへの拡張が必要である。さらに、実際の

ネットワーク環境で機器間の通信を実行した場合の経験を集め、この技術レポートを標準に高めることも必

要である。
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13 各メッセージ例 
本技術レポートで記述する HTTP 構文、XML 構文は、BN 記法に従い、参照する RFC 等の参考文献の内容

に沿って記述する。 

 

13.1 F1 SIP接続要求＜INVITE＞ 

INVITE ･･････ 

（中略） 

v=0 

o=- 634249773347155741 634249773347155741 IN IP4 client.kyoto.example.ne.jp 

s=- 

c=IN IP4 xxx.xxx.xxx.xxx 

t=0 0 

m=application 9 TCP xxxx 

b=AS:2000 

a=setup:active 

a=connection:new 

 

※注意点 

・SIP の記述は、JT-Q3402、JF-IETF-RFC4145 に従う。 

・"a=setup" にて、クライアント動作／サーバ動作を決定する（表 9-4 参照） 

 

13.2 F2 SIP応答＜200 OK＞ 

SIP/2.0 200 OK 

･･････ 

（中略） 

v=0 

o=- 0 0 IN IP4 client.kyoto.example.ne.jp 

s=- 

c=IN IP4 xxx.xxx.xxx.xxx 

t=0 0 

m=application 10000 TCP xxxx 

c=IN IP4 xxx.xxx.xxx.xxx 

b=AS:2000 

a=setup:passive 

a=connection:new 

 

※注意点 

・SIP の記述は、JT-Q3402、JF-IETF-RFC4145 に従う。 

・"a=setup"にて、クライアント動作／サーバ動作を決定する（表 9-4 参照） 

 

13.3 F5 SIPメディア追加要求＜UPDATE＞ 

reINVITE ･･････ 
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（中略） 

v=0 

o=- 634249773347155741 634249773347155741 IN IP4 client.kyoto.example.ne.jp 

s=- 

c=IN IP4 xxx.xxx.xxx.xxx 

t=0 0 

m=application 9 TCP xxxx 

b=AS:2000 

a=setup:active 

a=connection:new 

 

※注意点 

・SIP の記述は、JT-Q3402、JF-IETF-RFC4145 に従う。 

・"a=setup" にて、クライアント動作／サーバ動作を決定する（表 9-4 参照） 

 

13.4 F6 SIP応答＜200 OK＞ 

SIP/2.0 200 OK 

･･････ 

（中略） 

v=0 

o=- 0 0 IN IP4 client.kyoto.example.ne.jp 

s=- 

c=IN IP4 xxx.xxx.xxx.xxx 

t=0 0 

m=application 10000 TCP xxxx 

c=IN IP4 xxx.xxx.xxx.xxx 

b=AS:2000 

a=setup:passive 

a=connection:new 

 

※注意点 

・SIP の記述は、JT-Q3402、JF-IETF-RFC4145 に従う。 

・"a=setup"にて、クライアント動作／サーバ動作を決定する（表 9-4 参照） 

 

13.5 F11 暫定応答要求（Expect: 100-continue） 

POST /soap_action HTTP/1.1 

Content-Length: 318 

Content-Type: application/soap+xml; charset="utf-8"; 

Connection: Keep-Alive 

Expect: 100-continue 

User-Agent: ContentsTransfer/1.0 (ContentsTransferApplication; 1.0;) 

Host: xxx.xxx.xxx.xxx:10000 
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13.6 F12 暫定応答（HTTP/1.1 100 Continue） 

HTTP/1.1 100 Continue 

Connection: Keep-Alive 

Server: ContentsTransfer/1.0 (ContentsTransferApplication; 1.0;) x:150; 

 

13.7 F13 能力通知（InformCapability） 

<?xml version="1.0" encoding="UTF-8"?> 

<env:Envelope 

  xmlns:env="http://www.w3.org/2003/05/soap-envelope" 

  xmlns:ct="http://www.ttc.or.jp/mmsys/ct"> 

  <env:Body> 

    <ct:InformCapability> 

      <ct:SupportedFormats>image/jpg,image/tiff,!application/*</ct:SupportedFormats> 

    </ct:InformCapability> 

  </env:Body> 

</env:Envelope> 

 

13.8 F14 能力通知応答（InformCapabilityResponse） 

<?xml version="1.0" encoding="UTF-8"?> 

<env:Envelope 

  xmlns:env="http://www.w3.org/2003/05/soap-envelope" 

  xmlns:ct="http://www.ttc.or.jp/mmsys/ct"> 

  <env:Body> 

    <ct:InformCapabilityResponse /> 

  </env:Body> 

</env:Envelope> 

 

13.9 F17 コンテンツリスト取得要求（GetContentsList） 

<?xml version="1.0" encoding="UTF-8"?> 

<env:Envelope 

  xmlns:env="http://www.w3.org/2003/05/soap-envelope" 

  xmlns:ct="http://www.ttc.or.jp/mmsys/ct"> 

  <env:Body> 

    <ct:GetContentsList /> 

  </env:Body> 

</env:Envelope> 

 

13.10 F18 コンテンツリスト取得応答（GetContentsListResponse） 

<?xml version="1.0" encoding="UTF-8"?> 

<env:Envelope 

  xmlns:env="http://www.w3.org/2003/05/soap-envelope" 

  xmlns:ct="http://www.ttc.or.jp/mmsys/ct"> 

  <env:Body> 
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    <ct:GetContentsListResponse> 

      <ct:ContentsList> 

        <ct:Content> 

          <ct:Path>/</ct:Path> 

          <ct:Name>Photo001.jpg</ct:Name> 

          <ct:Size>326863</ct:Size> 

          <ct:Format>image/jpeg</ct:Format> 

          <ct:Title>Travel Photo No1</ct:Title> 

          <ct:Description>旅行に行ったときの写真 1</ct:Description> 

        </ct:Content> 

        <ct:Content> 

          <ct:Path>/photo/</ct:Path> 

          <ct:Name>Photo002.jpg</ct:Name> 

          <ct:Size>180421</ct:Size> 

          <ct:Format>image/jpeg</ct:Format> 

          <ct:Title>Travel Photo No2</ct:Title> 

          <ct:Description>旅行に行ったときの写真 2</ct:Description> 

        </ct:Content> 

      </ct:ContentsList> 

    </ct:GetContentsListResponse> 

  </env:Body> 

</env:Envelope> 

 

13.11 F21 コンテンツ 1 要求<HTTP GET> 

GET /Photo001.jpg HTTP/1.1 

Accept: image/jpeg 

Connection: Keep-Alive 

User-Agent: ContentsTransfer/1.0 (ContentsTransferApplication; 1.0;) 

Host: xxx.xxx.xxx.xxx:10000 

 

※注意点 

URL は、コンテンツリスト取得応答の<ct:Path>, <ct:Name>を使用 

 

13.12 F22 コンテンツ 1 送信<HTTP 200 OK> 

HTTP/1.1 200 OK 

Server: ContentsTransfer/1.0 (ContentsTransferApplication; 1.0;) x:150; 

Connection: Keep-Alive 

Content-Type: image/jpeg 

Content-Length: xxx 

 

（データ） 
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13.13 F29 能力確認要求（GetCapability） 

<?xml version="1.0" encoding="UTF-8"?> 

<env:Envelope 

  xmlns:env="http://www.w3.org/2003/05/soap-envelope" 

  xmlns:ct="http://www.ttc.or.jp/mmsys/ct"> 

  <env:Body> 

    <ct:GetCapability /> 

  </env:Body> 

</env:Envelope> 

 

13.14 F30 能力確認応答（GetCapabilityResponse） 

<?xml version="1.0" encoding="UTF-8"?> 

<env:Envelope 

  xmlns:env="http://www.w3.org/2003/05/soap-envelope" 

  xmlns:ct="http://www.ttc.or.jp/mmsys/ct"> 

  <env:Body> 

    <ct:GetCapabilityResponse> 

      <ct:SupportedFormats>image/jpg,image/tiff,!application/*</ct:SupportedFormats> 

    </ct:GetCapabilityResponse> 

  </env:Body> 

</env:Envelope> 

 

13.15 F33 ジョブ開始要求（CreateJob） 

<?xml version="1.0" encoding="UTF-8"?> 

<env:Envelope 

  xmlns:env="http://www.w3.org/2003/05/soap-envelope" 

  xmlns:ct="http://www.ttc.or.jp/mmsys/ct"> 

  <env:Body> 

    <ct:CreateJob> 

      <ct:ContentName>Photo002.jpg</ct:ContentName> 

      <ct:ContentSize>180421</ct:ContentSize> 

      <ct:Format>image/jpeg</ct:Format> 

    </ct:CreateJob> 

  </env:Body> 

</env:Envelope> 

 

13.16 F34 ジョブ開始応答（CreateJobResponse） 

<?xml version="1.0" encoding="UTF-8"?> 

<env:Envelope 

  xmlns:env="http://www.w3.org/2003/05/soap-envelope" 

  xmlns:ct="http://www.ttc.or.jp/mmsys/ct"> 

  <env:Body> 

    <ct:CreateJobResponse> 
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      <ct:JobID>28</ct:JobID> 

      <ct:Path>/photodata</ct:Path> 

    </ct:CreateJobResponse> 

  </env:Body> 

</env:Envelope> 

 

13.17 F37 コンテンツ 1 送信<HTTP POST> 

-----------------------------7da11b1cd70ac2 

Content-Disposition: form-data; name="xxx"; filename=" Photo002.jpg " 

Content-Type: image/jpeg 

 

(データ) 

-----------------------------7da11b1cd70ac2-- 

 

13.18 F49 コンテンツ送信終了（EndSendContent） 
<?xml version="1.0" encoding="UTF-8"?> 
<env:Envelope 
  xmlns:env="http://www.w3.org/2003/05/soap-envelope" 
  xmlns:ct="http://www.ttc.or.jp/mmsys/ct"> 
  <env:Body> 
    <ct:EndSendContent /> 
  </env:Body> 
</env:Envelope> 
 

13.19 F50 コンテンツ送信終了応答（EndSendContentResponse） 
<?xml version="1.0" encoding="UTF-8"?> 
<env:Envelope 
  xmlns:env="http://www.w3.org/2003/05/soap-envelope" 
  xmlns:ct="http://www.ttc.or.jp/mmsys/ct"> 
  <env:Body> 
    <ct:EndSendContentResponse /> 
  </env:Body> 
</env:Envelope> 
 

13.20 F53 セッション持続要求（ContinueSession） 
<?xml version="1.0" encoding="UTF-8"?> 
<env:Envelope 
  xmlns:env="http://www.w3.org/2003/05/soap-envelope" 
  xmlns:ct="http://www.ttc.or.jp/mmsys/ct"> 
  <env:Body> 
    <ct:ContinueSession /> 
  </env:Body> 
</env:Envelope> 
 

13.21 F54 セッション持続応答（ContinueSessionResponse） 
<?xml version="1.0" encoding="UTF-8"?> 
<env:Envelope 
  xmlns:env="http://www.w3.org/2003/05/soap-envelope" 
  xmlns:ct="http://www.ttc.or.jp/mmsys/ct"> 
  <env:Body> 
    <ct:ContinueSessionResponse /> 
  </env:Body> 
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</env:Envelope> 
 

14 本編記載のSOAPメッセージのXMLスキーマ 
 
<?xml version="1.0" encoding="UTF-8"?> 
<xs:schema xmlns:xs="http://www.w3.org/2001/XMLSchema" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
  targetNamespace="http://www.ttc.or.jp/mmsys/ct" xmlns:ct="http://www.ttc.or.jp/mmsys/ct" 
  elementFormDefault="unqualified" attributeFormDefault="unqualified"> 
 
  <xs:element name="InformCapability"> 
    <xs:complexType> 
      <xs:sequence> 
        <xs:element ref="ct:SupportedFormats" /> 
        <xs:element name="Private" minOccurs="0" /> 
      </xs:sequence> 
    </xs:complexType> 
  </xs:element> 
 
  <xs:element type="xs:string" name="SupportedFormats" /> 
 
  <xs:element name="GetCapability"> 
    <xs:complexType> 
      <xs:sequence> 
        <xs:element name="Options" minOccurs="0" /> 
        <xs:element name="Private" minOccurs="0" /> 
      </xs:sequence> 
    </xs:complexType> 
  </xs:element> 
 
  <xs:element name="GetContentsList"> 
    <xs:complexType> 
      <xs:sequence> 
        <xs:element name="Private" minOccurs="0" /> 
      </xs:sequence> 
    </xs:complexType> 
  </xs:element> 
 
  <xs:element name="CreateJob"> 
    <xs:complexType> 
      <xs:sequence> 
        <xs:element ref="ct:ContentName" /> 
        <xs:element ref="ct:ContentSize" /> 
        <xs:element ref="ct:Format" /> 
        <xs:element name="Options" minOccurs="0"> 
        </xs:element> 
        <xs:element name="Private" minOccurs="0" /> 
      </xs:sequence> 
    </xs:complexType> 
  </xs:element> 
 
  <xs:element type="xs:string" name="ContentName" /> 
 
  <xs:element name="ContentSize"> 
    <xs:simpleType> 
      <xs:restriction base="xs:long"> 
        <xs:minInclusive value="0" /> 
        <xs:maxInclusive value="9223372036854775807" /> 
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      </xs:restriction> 
    </xs:simpleType> 
  </xs:element> 
 
  <xs:element type="xs:string" name="Format" /> 
 
  <xs:element name="EndSendContent"> 
    <xs:complexType> 
      <xs:sequence> 
        <xs:element name="Private" minOccurs="0" /> 
      </xs:sequence> 
    </xs:complexType> 
  </xs:element> 
 
  <xs:element name="ContinueSession"> 
    <xs:complexType> 
      <xs:sequence> 
        <xs:element name="Private" minOccurs="0" /> 
      </xs:sequence> 
    </xs:complexType> 
  </xs:element> 
 
  <xs:element name="InformCapabilityResponse"> 
    <xs:complexType> 
      <xs:sequence> 
        <xs:element name="Private" minOccurs="0" /> 
      </xs:sequence> 
    </xs:complexType> 
  </xs:element> 
 
  <xs:element name="GetCapabilityResponse"> 
    <xs:complexType> 
      <xs:sequence> 
        <xs:element ref="ct:SupportedFormats" /> 
        <xs:element name="Options" minOccurs="0" /> 
        <xs:element name="Private" minOccurs="0" /> 
      </xs:sequence> 
    </xs:complexType> 
  </xs:element> 
 
  <xs:element name="GetContentsListResponse"> 
    <xs:complexType> 
      <xs:sequence> 
        <xs:element ref="ct:ContentsList" /> 
        <xs:element name="Private" minOccurs="0" /> 
      </xs:sequence> 
    </xs:complexType> 
  </xs:element> 
 
  <xs:element name="ContentsList"> 
    <xs:complexType> 
      <xs:sequence maxOccurs="unbounded"> 
        <xs:element ref="ct:Content" /> 
      </xs:sequence> 
    </xs:complexType> 
  </xs:element> 
 
  <xs:element name="Content"> 
    <xs:complexType> 
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      <xs:sequence> 
        <xs:element ref="ct:Path" /> 
        <xs:element ref="ct:Name" /> 
        <xs:element ref="ct:Size" /> 
        <xs:element ref="ct:Format" /> 
        <xs:element ref="ct:Title" minOccurs="0" /> 
        <xs:element ref="ct:Description" minOccurs="0" /> 
        <xs:element name="Options" minOccurs="0" /> 
      </xs:sequence> 
    </xs:complexType> 
  </xs:element> 
 
  <xs:element type="xs:string" name="Path" /> 
 
  <xs:element type="xs:string" name="Name" /> 
 
  <xs:element name="Size"> 
    <xs:simpleType> 
      <xs:restriction base="xs:long"> 
        <xs:minInclusive value="0" /> 
        <xs:maxInclusive value="9223372036854775807" /> 
      </xs:restriction> 
    </xs:simpleType> 
  </xs:element> 
 
  <xs:element type="xs:string" name="Title" /> 
 
  <xs:element type="xs:string" name="Description" /> 
 
  <xs:element name="CreateJobResponse"> 
    <xs:complexType> 
      <xs:sequence> 
        <xs:element ref="ct:JobID" /> 
        <xs:element ref="ct:Path" /> 
        <xs:element name="Options" minOccurs="0" /> 
        <xs:element name="Private" minOccurs="0" /> 
      </xs:sequence> 
    </xs:complexType> 
  </xs:element> 
 
  <xs:element name="JobID"> 
    <xs:simpleType> 
      <xs:restriction base="xs:int"> 
        <xs:minInclusive value="-4" /> 
        <xs:maxInclusive value="2147483647" /> 
      </xs:restriction> 
    </xs:simpleType> 
  </xs:element> 
 
  <xs:element name="EndSendContentResponse"> 
    <xs:complexType> 
      <xs:sequence> 
        <xs:element name="Private" minOccurs="0" /> 
      </xs:sequence> 
    </xs:complexType> 
  </xs:element> 
 
  <xs:element name="ContinueSessionResponse"> 
    <xs:complexType> 
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      <xs:sequence> 
        <xs:element name="Private" minOccurs="0" /> 
      </xs:sequence> 
    </xs:complexType> 
  </xs:element> 
 
</xs:schema> 
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付属資料A AnnexA  FAX 機能のためのネゴシエーション方法 

 

本付属資料の適用範囲は、本編のコンテンツ転送手順（接続形態２、接続形態３）を用いて画像データ送受

信を行う際の信号定義について記述する。 

画像データ送受信を利用する主要機能として、ストレージ機能、プリンタ機能、Fax 機能、を想定し、また

ベンダー独自に機能拡張が可能な能力交換の方法を定義する。 

能力の交換については、送信側は機能を指定して受信側に能力確認要求を行い、受信側は要求された機能

に関する能力確認応答を行うものとする。 

主要機能としては、 

１．ストレージ機能 

受信されたコンテンツを受信側機器で記憶し、操作により取り出すことが可能な機能。 

２．プリンタ機能 

受信されたコンテンツを受信側機器に接続されたプリンタで印刷出力することが可能な機能。 

プリンタとしての印刷時のパラメータ指定が可能な機能が含まれる。 

３．Fax 機能 

受信されたコンテンツを受信側機器のプリンタで印刷出力することが可能な機能。 

Fax 通信をコンテンツ転送で代替可能となるような機能が含まれる。 

を対象としている。 

 

A.1 SIP/SDP 様式 

本編 8.1 項に従う。 

 

A.2 能力確認様式 

能力確認フェーズでの追加オプションを記載する。 

 

A.2.1 AnnexA 能力確認要求（GetCapability） 追加オプション 
能力確認フェーズにおいて、能力確認要求（本編 10.2.2 項 及び 9.7 項 シーケンス F29 参照）に追加設定

できるオプションのタグを表A- 1 に規定する。 
 

表 A- 1／TR-1038 AnnexA 能力確認要求（GetCapability） 追加オプション 
変数 M/O 内容 

 <Options> M － 
  <cta:TerminalIdentification> O 機器に設定された名称 
  <cta:Password> O パスワードを設定 
  <cta:CapabilityList> O － 
   <cta:Capability> M － 
    <CapabilityName> M 能力を要求する機能名を設定 
    <ArgumentsList> O － 
     <Argument> M － 
      <Name> M 引数名の設定 
      <Value> M 引数の値を設定 

※「M」=必須、「O」=オプション  
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A.2.1.1 <Options> 
<Options>を設定しないで能力確認要求が行われた場合、受信側は全機能の能力確認応答を返すこと。送信

側機器の実装機能が限定されていて不要な能力応答を受け取りたくない場合、<cta:CapabilityList>以下

<CapabilityName>で能力確認機能を指定して必要機能のみの能力応答を受け取ることが出来る。 
注）<Options>タグは子要素が空きかそうでないかにかかわらず必ず設定すること。 
 

A.2.1.2 <cta:TerminalIdentification> 
<cta:TerminalIdentification>タグは、能力確認応答において受信側機器に設定された名称を通知する際に使用

する。 意図した接続先に正しく接続されたか（誤接続防止）、能力確認要求側が判断するのに使用でき

る。 
 

A.2.1.3 <cta:Password> 

パスワードを設定。今回は詳細規定しない。 
 

A.2.1.4 <cta:Capability> 

<cta:Capability>は子要素の<CapabilityName>により識別される。 

<cta:CapabilityList>の子要素には最低一つの<cta:Capability>を設定すること。<cta:CapabilityList>の子要素とし

て、２つ以上の<cta:Capability>を設定可能とするが、同内容の<CapabilityName>を含む<cta:Capability>を複数

設定しないこと。 

 

A.2.1.5 <CapabilityName> 
能力確認を要求する機能名を指定するとき、 <cta:CapabilityList> と <cta:Capability> とを使用して

<CapabilityName>に機能名を設定する。AnnexAでは A.2.2 項に定義された機能名を設定できる。複数個設定

する場合は、<cta:Capability>以下を複数回記述し、また別Annexの機能名と混在しての設定もできる。 
 

A.2.1.6 <Name> 、<Value> 

機能別に能力確認を要求する際、<ArgumentsList>、<Argument>を使って<CapabilityName>毎に受信側に引数

を通知することができる。 
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A.2.2 AnnexA 能力確認要求  CapabilityName/Arguments 定義 
能力確認要求を行うとき、A.2.1 項の<CapabilityName>とArgumentsの<Name>各タグに設定する値を 表A- 2
に規定し、<Name>に対応する<Value>設定値を項目ごとに A.2.2.1 項以降に規定する。 
 

表 A- 2／TR-1038 AnnexA 能力確認要求  CapabilityName/Arguments 定義 
CapabilityName ArgumentのName M/O 内容 

Storage  O "Storage"に関する能力を要求 
Printer  O "Printer"に関する能力を要求 
Fax  O "Fax"に関する能力を要求 
ProprietaryMode  O "ProprietaryMode"に関する能力を要求 
 CountryCode M 送信側機器のCountry Codeを設定 
 VendorCode M 送信側機器のTerminal Provider Codeを設定 
 VendorCapability M 送信側機器のTerminal Provider-Oriented Codeを設定 

※「M」=必須、「O」=オプション  

 

A.2.2.1 Storage 
ファイルサーバや取り外し可能な拡張メモリ等を装備する等受信するファイルを保存する機能について、受

信側に能力確認を要求する際に設定する。 
 

A.2.2.2 Printer 
受信ファイルを印刷出力する機能について、受信側に能力確認を要求する際に設定する。 

 

A.2.2.3 Fax 
ファクシミリ送受信同等機能について、受信側に能力確認を要求する際に設定する。 
 

A.2.2.4 ProprietaryMode 
ベンダー独自拡張機能について、受信側に能力確認を要求する際に設定する。設定する場合は送信側の独

自拡張機能情報:"CountryCode""VendorCode""VendorCapability"を必ず設定し、提示した送信側の独自拡張機

能情報を受信側機器が解釈出来た場合、受信側は能力確認応答で受信側の独自拡張機能情報を返す。 
 

A.2.2.4.1. <CountryCode> 

送信側機器の国別情報を設定する。正の short（Integer 16 bit）値に変換して設定(0-255）する。 

CountryCode の値は T.35 に従う。 

 

A.2.2.4.2. <VendorCode> 
送信側機器の Terminal Provider Code を設定する。short（Integer 16 bit）値に変換して設定(0-65535）する。 
CountryCode が 0（日本）の場合、VenderCode の値は郵政省告示で指定されたコードに従う。 
 

A.2.2.4.3. <VendorCapability> 
送信側機器の Terminal Provider-Oriented Code（バイナリ）を Hex 変換して設定する。 
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A.2.3 AnnexA 能力確認応答（GetCapabilityResponse） 追加オプション 

能力確認フェーズにおいて、能力確認応答（本編 10.3.2 項 及び 9.7 項 シーケンス F30 参照）に追加設定

できるオプションのタグを表A- 3 に規定する。 

 

表 A- 3／TR-1038 AnnexA 能力確認応答（GetCapabilityResponse） 追加オプション 
変数 M/O 内容 

 <Options> M 拡張用 
  <cta:TerminalIdentification> O 機器に設定された名称 
  <cta:Password> O パスワードを設定 
  <cta:CapabilityList> O  
   <cta:Capability> M  
    <CapabilityName> M 能力応答する機能名を設定 
    <ArgumentsList> O  
     <Argument> M  
      <Name> M 引数名の設定 
      <Value> M 引数の値を設定 

※「M」=必須、「O」=オプション 

 

A.2.3.1 <Options> 
１つ以上の機能について能力確認応答を返す場合に設定すること。送信側が機能名を指定して能力確認を要

求し、かつ指定された機能名が受信側で未実装の場合、受信側は<CapabilityName>に機能名を設定した

<ArgumentsList>以降が空の能力確認応答を返すこと。送信側で機能名を指定せず<Options>以下が空の能力

確認を要求した場合、受信側は実装された機能名について応答可能な全ての能力確認応答を返すこと。解釈

できない機能名・引数等の変数が送信側から通知された場合、受信側は解釈できるもののみ解釈し、解釈で

きないものは無視すること。 
注）<Options>タグは子要素が空きかそうでないかにかかわらず必ず設定すること。 
 

A.2.3.2 <cta:TerminalIdentification> 
<cta:TerminalIdentification>タグは、能力確認応答において受信側機器に設定された名称を通知する際に使用

する。 意図した接続先に正しく接続されたか（誤接続防止）、能力確認要求側が判断するのに使用でき

る。 
 

A.2.3.3 <cta:Password> 

パスワードを設定。今回は詳細規定しない。 
 

A.2.3.4 <cta:Capability> 
<cta:Capability>は子要素の<CapabilityName>により識別される。 
GetCapability における<cta:Capability>１つに対して、<GetCapabilityResponse>における<cta:Capability>タグ 1
つを設定する。<cta:Capability>が複数ある場合、それぞれの<cta:Capability>に対して同じ<CapabilityName>
を<cta:Capability>に設定することにより、GetCapability における<cta:Capability>と<GetCapabilityResponse>に
おける<cta:Capability>の 1 対 1 の対応関係になるようにすること。 
また、<cta:Capability>を複数設定する場合には、受信した<GetCapability>の中に現れる<cta:Capability>と同

じ順番で、<GetCapabilityResponse>の<cta:CapabilityList>の子要素に設定すること。 
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A.2.3.5 <CapabilityName> 
能力確認に応答するとき、<cta:CapabilityList>と<cta:Capability>とを使用して<CapabilityName>に機能名を設

定する。AnnexAでは A.2.4 項に定義された機能名と詳細な引数を設定できる。複数個設定する場合は、

<cta:Capability>以下を複数回記述し、また別Annexの機能名と混在しての設定もできる。 
 

A.2.3.6 <Name> 、<Value> 

機能別の能力確認応答を返す際、<ArgumentsList>、<Argument>を使って<CapabilityName>毎に実装された能

力の詳細を引数に設定して送信側に通知できる。 
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A.2.4 AnnexA 能力確認応答  CapabilityName/Arguments 定義 
能力確認応答を行うとき、A.2.3 の<CapabilityName>とArgumentsの<Name>各タグに設定する値を表A- 4 に

規定し、<Name>に対応する<Value>設定値を項目ごとに A.2.4.1 項以降に規定する。"SupportedFormats"や 
"PaperSize"など複数の値を返す場合、優先度の高い方を先に記述すること。 
 

表 A- 4／TR-1038 AnnexA 能力確認応答  CapabilityName/Arguments 定義 
CapabilityName ArgumentのName M/O 内容 

Storage  O "Storage"に関する能力を要求 
 SupportedFormats M 対応コンテンツフォーマット 
 MaxFileSize M 通信可能なデータ・サイズの上限値 
 FileCapacity M 受信保存可能な総ファイル容量 
Printer  O "Printer"に関する能力を要求 
 SupportedFormats M ファイル・フォーマット(pdf,tiff,etc.) 
 MaxFileSize M 通信可能なデータ・サイズの上限値 
 FileCapacity M 受信保存可能な総ファイル容量 
 MaxJobs M 受信可能なジョブ数 
 ColorSupported O カラー印刷の可否 
 Resolution O 印刷解像度 
 Quality O 印刷品質の種類(draft,normal,high) 
 PaperSize O 紙サイズの種類 
 FinishingsSupported O フィニッシャーの有無 
 NumberUpSupported O Nup印刷の可否 
 OrientationSupported O 印刷方向指定の可否 
 SidesSupported O 両面印刷の可否 
 CopiesSupported O 部数指定印刷の可否 
 CollateSupported O 丁合い印刷の可否 
 SpecifyCasetteSupported O カセット指定の可否 
 JobPrioritySupported O ジョブ優先度の上限値 
Fax  O "Fax"に関する能力を要求 
 SupportedFormats M "image/tiff","image/tiff-fx"から提示 
 SupportedTiffType M "S","F","J","C","L","M"から提示 
 MaxFileSize M 通信可能なデータ・サイズの上限値 
 FileCapacity M 受信保存可能な総ファイル容量 
 MaxJobs M 受信可能なジョブ数 

 ResolutionColor M カラー／グレースケール画像の縦横解像度を

応答 

 PaperSizeColor M カラー／グレースケール画像の紙サイズを応

答 

 ResolutionBW O 白黒画像の縦横解像度を応答 

 PaperSizeBW O 白黒画像の紙サイズを応答 
 FcodeSupported O Fコード機能の可否を応答 
ProprietaryMode  O "ProprietaryMode"に関する能力を要求 
 CountryCode M Country Code 
 VendorCode M Terminal Provider Code 
 VendorCapability M Terminal Provider-Oriented Code 

※「M」=必須、「O」=オプション  
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A.2.4.1 Storage 
ファイルサーバや取り外し可能な拡張メモリ等を装備する等受信するファイルを保存する機能について、

受信側がこの機能を実装している場合に能力確認応答に設定する。 

 

A.2.4.1.1. SupportedFormats 
"Storage"機能として許容できるファイルフォーマットを設定する。 
タグ内に記載する内容は、原則IANA登録されたMIME-TypeをCSVリスト形式で記載する。（本編 10.3.2.1 項

「能力確認応答」を参照） 
 
A.2.4.1.2. MaxFileSize 
1 回の受信で受信可能な１つのファイルのサイズのバイト数の上限値を設定する。 
1 以上の long（Integer 64 bit）値が使用可能 (1-9223372036854775807）である。 
 

A.2.4.1.3. FileCapacity 
1 回の受信で受信可能な複数のファイルの総ファイル容量のバイト数を設定する。 
1 以上の long 値を使用可能である。 
 

A.2.4.2 Printer 
プリンタ機能について、受信側がこの機能を実装している場合に能力確認応答を設定する。 

 

A.2.4.2.1. SupportedFormats 
"Printer" 機能として許容できるファイルフォーマットを設定する。タグ内に記載する内容は、原則IANA登

録されたMIME-TypeをCSVリスト形式で記載する。（本編 10.3.2.1 項「能力確認応答」を参照） 
 

"image/tiff" : (必須)  (RFC3302)  
 
その他の代表的なファイルフォーマット例 
"image/jpeg" : (RFC2045, RFC2046) 
"application/pdf" : (RFC3778) 

 
A.2.4.2.2. MaxFileSize 
1 回の受信で受信可能な１つのファイルのサイズのバイト数の上限値を設定する。 
1 以上の long 値を使用可能である。 
 

A.2.4.2.3. FileCapacity 
1 回の受信で受信可能な複数のファイルの総ファイル容量のバイト数を設定する。 
1 以上の long 値を使用可能である。 
 

A.2.4.2.4. MaxJobs 
1 回の受信で受信可能な CreateJob の回数の上限値を設定する。 
1 以上の short（Integer 16 bit）値を使用可能 (1-32767）である。 
 

A.2.4.2.5. ColorSupported 
カラー印刷のサポートを設定する。 
 

"color"  : カラー印刷をサポート 
"monochrome" : 白黒印刷をサポート 

 

A.2.4.2.6. Resolution 
サポートしている印刷解像度をすべてカンマで区切って設定する。 
（例．"1200x1200dpi,600x600dpi,300x300dpi"） 
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A.2.4.2.7. Quality 
サポートしている印刷品質をすべてカンマで区切って設定する。 
 

"draft"  : ドラフト 
"normal"  : 通常 
"high"  : きれい 

 

A.2.4.2.8. PaperSize 
サポートしている印刷用紙サイズをすべてカンマで区切って設定する。拡張する場合は RFC2566 14. 
APPENDIX C:  "media" keyword values に準ずる。 
 

"auto"  : 自動調整 
"iso a3"  : ISO A3 297 x 420 mm 
"iso a4"  : ISO A4 210 x 297 mm 
"iso a5"  : ISO A5 148 x 210 mm 
"jis-b4"  : JIS B4 257 x 364 mm 
"jis b5"  : JIS B5 182 x 257 mm 
"na-letter" : Letter 8.5 x 11 in (216 x 279 mm) 
"na-legal" : Legal 8.5 x 14 in (216 x 356 mm) 
"ledger"  : Ledger 11 x 17 in (279 x 432 mm) 

 
A.2.4.2.9. FinishingsSupported 
サポートしているフィニッシング方式をすべてカンマで区切って設定する。 
何もサポートしていない場合は"none"を設定する。 
 

"none"   : 無し 
"staple"   : ステープルする 
"punch"   : 穴をあける 
"cover"   : 表紙を足す 
"bind"   : 製本処理する 
"saddle-stitch"  : 中綴じ製本処理する 
"staple-top-left"  : 上左隅をステープルする 
"staple-bottom-left"  : 下左隅をステープルする 
"staple-top-right"  : 上右隅をステープルする 
"staple-bottom-right" : 下右隅をステープルする 
"staple-dual-left"  : 左側 2 箇所をステープルする 
"staple-dual-top"  : 上側 2 箇所をステープルする 
"staple-dual-right"  : 右側 2 箇所をステープルする 
"staple-dual-bottom" : 下側 2 箇所をステープルする 
"punch-left"  : 左側に穴をあける 
"punch-top"  : 上側に穴をあける 
"punch-right"  : 右側に穴をあける 
"punch-bottom"  : 下側に穴をあける 

 

A.2.4.2.10. NumberUpSupported 
サポートしている Nup 印刷をすべてカンマで区切って設定する。 
１以上の short（Integer 16 bit）値を使用可能 (1-32767）である。 

（例． "2,4,9,16" : 2in1 , 4in1 , 9in1 , 16in1 ） 
 

A.2.4.2.11. OrientationSupported 
サポートしている印刷紙方向をすべてカンマで区切って設定する。 
 

"portrait"  : 縦 
"landscape"  : 横 

 

A.2.4.2.12. SidesSupported 
サポートしている両面印刷の種類をすべてカンマで区切って設定する。 
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"one-sided"  : 片面印刷 
"two-sided-long-edge" : 長辺とじ両面印刷 
"two-sided-short-edge" : 短辺とじ両面印刷 

 

A.2.4.2.13. CopiesSupported 
複数部数の印刷出力が可能な場合、印刷可能な部数の上限値を返す。 
１以上の short（Integer 16 bit）値を使用可能 (1-32767）である。 

（例． "999" : 999 部まで印刷可能 ） 
 

A.2.4.2.14. CollateSupported 
サポートしているソート出力機能を返す。 
 

"collate"  : 「部単位」で印刷出力 
"sort"   : 「ページ単位」で印刷出力 

 

A.2.4.2.15. SpecifyCasetteSupported 
印刷用紙のカセットを指定して印刷できる場合は、指定可能なカセット番号の最大値を設定する。１以上

の short（Integer 16 bit）値を使用可能(1-32767） 
 

A.2.4.2.16. JobPrioritySupported 
優先度別にジョブを処理できる場合、設定可能なジョブの最高優先度を数字で返す。 
1 以上の short（Integer 16 bit）値を使用可能(1-32767）で、数字が大きいほど優先度が高い。 

（例．5 段階の優先度を処理できる場合は"5"を返す。） 
 
A.2.4.3 Fax 
Fax 受信機能について、受信側がこの機能を実装している場合に能力確認応答に設定する。 
Fax受信機能とは、A.2.4.3.5 項に示すファイルタイプを受信して印刷、表示、もしくは保存ができる機能を

指す。 
 

A.2.4.3.1. SupportedFormats 
"Fax"機能として許容できるファイルフォーマットを設定する。 
タグ内に記載する内容は、原則IANA登録されたMIME-TypeをCSVリスト形式で記載する。（本編 10.3.2.1 項

「能力確認応答」 を参照） 
 

"image/tiff" : TIFF Profile S, F に対応するとき設定する (RFC3302) 
"image/tiff-fx" : TIFF Profile C, J, L, M に対応するとき設定する (RFC3950) 

 
 

A.2.4.3.2. MaxFileSize 
1 回の受信で受信可能な１つのファイルのサイズのバイト数の上限値を設定する。 
1 以上の long 値を使用可能である。 
 

A.2.4.3.3. FileCapacity 
1 回の受信で受信可能な複数のファイルの総ファイル容量のバイト数を設定する。 
1 以上の long 値を使用可能である。 
 

A.2.4.3.4. MaxJobs 
1 回の受信で受信可能な CreateJob の回数の上限値を設定する。 
1 以上の short（Integer 16 bit）値を使用可能 (1-32767）である。 
 

A.2.4.3.5. SupportedTiffType 
受信するTIFFファイルの許容できるタイプを設定する。必須の"S"と "F","J","C","L","M"の中の対応する全

てをカンマで区切って応答する。（参照:RFC3949） 
 

"S" :  Minimal black-and-white profile, using binary MH compression 
"F" :  Extended black-and-white profile, using binary MH, MR, and MMR compression 
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"J" :  Lossless JBIG black-and-white profile, with JBIG compression 
"C" :  Lossy color and grayscale profile, using JPEG compression 
"L" :  Lossless color and grayscale profile, using JBIG compression 
"M" :  Mixed raster content profile, using a combination of existing compression methods 

 

A.2.4.3.6. ResolutionColor 
"image/tiff-fx"に対応する場合、受信側で処理可能なカラー／グレースケール画像の縦横解像度の全ての組

合せをカンマで区切って応答する。"200x200dpi"は必須となる。 
 

"100x100dpi" 
"200x200dpi"  (必須) 
"300x300dpi" 
"400x400dpi" 

 
A.2.4.3.7. PaperSizeColor 
"image/tiff-fx"に対応する場合、受信側で処理可能なカラー／グレースケール画像の紙サイズの全ての組合

せをカンマで区切って応答する。"ISO A4"は必須となる。 
 

"iso-a3"  : ISO A3 
"iso-a4"  : ISO A4  (必須) 
"iso-b4"  : ISO B4 
"na-letter" : North American Letter 
"na-legal" : North American Legal 

 
A.2.4.3.8. ResolutionBW 
"image/tiff"に対応する場合、受信側で処理可能な白黒画像の縦横解像度の全ての組合せをカンマで区切って

応答する。 "204x98dpi"及び"204x196dpi"は必須となる。 
 

"204x98dpi"  (必須) 
"204x196dpi" (必須) 
"200x100dpi" 
"200x200dpi" 
"204x391dpi" 
"300x300dpi" 
"408x391dpi" 
"400x400dpi" 

 
A.2.4.3.9. PaperSizeBW 
"image/tiff"に対応する場合、受信側で処理可能な白黒画像の紙サイズの全ての組合せをカンマで区切って応

答する。 "ISO A4"は必須となる。 
 

"iso-a3"  : ISO A3 
"iso-a4"  : ISO A4 (必須) 
"iso-b4"  : ISO B4 
"na-letter" : North American Letter 
"na-legal" : North American Legal 

 
A.2.4.3.10. FcodeSupported 
F コード機能（F コード（１）,F コード（２）,F コード（３）に従う装置）への対応が可能な場合は"true"、
出来ない場合は"false"を設定する。 
 

"Supported" : F コード指定 可能 
"NotSupported"  : F コード指定 不可 

 

A.2.4.4 ProprietaryMode 
ベンダー独自拡張機能について、送信側の独自拡張機能情報を解釈出来た場合、受信側の独自拡張機能情

報を応答する。 
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A.2.4.4.1. CountryCode 
送信側機器の国別情報を設定する。 
 

A.2.4.4.2. VendorCode 
送信側機器の Terminal Provider Code を設定する。 

 

A.2.4.4.3. VendorCapability 
送信側機器の Terminal Provider-Oriented Code（バイナリ）を Hex 変換して設定する。 
 

A.3 ジョブ開始通知様式 

A.3.1 AnnexA ジョブ開始要求（CreateJob） 追加オプション 
 
ジョブ生成フェーズにおいて、ジョブ開始要求（本編 10.2.4 項 及び 9.7 項 シーケンス F33,F41 参照）に追

加設定できるオプションのタグを表A- 5 に規定する。 
 

表 A- 5／TR-1038 AnnexA ジョブ開始要求（CreateJob） 追加オプション 
変数 M/O 内容 

 <Options> M 拡張用 
  <cta:Title> O ファイルタイトル 
  <cta:Descriptions> O コンテンツ説明文 
  <cta:Hash> O ハッシュ値を設定 
   <Algorithm> M ハッシュアルゴリズムを設定 
   <Value> M 送信ファイルのハッシュ値を設定 
  <cta:RequestList> M  
   <cta:Request> M  
    <ProcessName> M 送信するファイルに対する受信側の処理メソッドを

設定 
    <ArgumentsList> O  
     <Argument> M  
      <Name> M 受信側の処理メソッドの引数名を設定 
      <Value> M 受信側の処理メソッドの引数の値を設定 

※「M」=必須、「O」=オプション  

 

A.3.1.1 <Options> 
AnnexA の能力を指定してジョブ開始要求を行う場合は<ProcessName>を必ず設定する。 
注）<Options>タグは子要素が空きかそうでないかにかかわらず必ず設定すること。 
 
A.3.1.2 <cta:Title> 
送信するファイルのファイルタイトルを設定する。 
 

A.3.1.3 <cta:Descriptions> 

送信するファイルのコンテンツ説明文を設定する。コンテンツの説明・送付目的・メッセージ等を送信時に

送信側機器に入力し、受信側機器ではログや着呼通知等にその内容を表示する。 

 

A.3.1.4 <cta:Hash> 
送信ファイルのハッシュ値を指定する場合に設定する。 
 

A.3.1.5 <Algorithm> 
ハッシュ値計算のアルゴリズムを設定する 
 

"MD5"  :  RFC1321 参照 
"SHA-1"  :  NIST FIPS PUB 180-1 "Secure Hash Standard" 参照 
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A.3.1.6 <Value> 

<Algorithm>で指定された、送信ファイルのハッシュ計算値を、受信側機器でのコンテンツ改ざんチェックの

目的で通知する。ファイル受信側におけるリアルタイムなハッシュ値のチェック、及び送信側へのレスポン

スは規定しない。受信終了後に受信側でハッシュ値のチェックをすることで、受信時の改ざんの有無が検知

可能である。 

 

A.3.1.7 <cta:Request> 

<cta:Request>は子要素の<ProcessName>により識別される。 

<cta:RequestList>の子要素には最低一つの<cta:Request>を設定すること。<cta:RequestList>の子要素として、

２つ以上の<cta:Request>を設定可能とするが、同内容の<ProcessName>を含む<cta:Request>を複数設定しない

こと。また、<cta:Request>を複数設定する場合には、実行を期待する順番に先頭から末尾に向かって

<cta:Request>を<cta:RequestList>の子要素として設定すること。 

 

A.3.1.8 <ProcessName> 
送信するファイルに対する受信側の処理メソッドを設定する。AnnexAでは A.3.2 項に定義された

ProcessName 及び Arguments を<cta:RequestList>と<cta:Request>とを使用して<ProcessName>に設定する。

送信するファイル一つに対して、同時に複数の処理を要求できる。 
 

A.3.1.9 <Name> 
受信側の処理メソッドの引数名を設定する。 
 

A.3.1.10 <Value> 
受信側の処理メソッドの引数の値を設定する。 
 

A.3.2 AnnexA ジョブ開始要求  ProcessName/Arguments 定義 
ジョブ開始要求を行うとき、A.3.1 項の<ProcessName>と<Arguments>の<Name>各タグに設定する値を 表A- 
6 に規定し、<Name>に対応する<Value>設定値を項目ごとにA.3.2.1 以降に規定する。 
 

表 A- 6／TR-1038 AnnexA ジョブ開始要求  ProcessName/Arguments 定義 
ProcessName Arguments M/O 内容 

Storage  O 送信するファイルをサーバ等に保存する 
Printer  O 送信するファイルの内容を印刷する 
 Color O カラー/グレースケール/白黒印刷を指定 
 Resolution O 印刷解像度を指定 
 Quality O 印刷品質を指定 
 PaperSize O 用紙サイズを指定 
 Finishings O フィニッシャー処理を指定 
 NumberUp O Nin1を指定 
 Orientation O 印刷方向を指定 
 Sides O 片面／両面印刷を指定 
 Copies O 印刷部数を指定 
 Collate O 丁合い印刷指定 
 SpecifyCasette O 用紙カセット番号を指定 
 JobPriority O ジョブ優先度を指定 
Fax  O ファクシミリモードでファイル送信する 
 TiffType O "S","F","J","C","L","M"を指定 
 Resolution O 解像度を指定 
 PaperSize O 画像サイズを指定 
 FcodeSub O Fコード SUB (1～20桁の数字) 
 FcodeSid O Fコード SID (1～20桁の数字) 
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ProprietaryMode  O 独自拡張モード 
※「M」=必須、「O」=オプション  

 

A.3.2.1 Storage 
送信するファイルを受信側のファイルサーバ等に保存するとき設定する。 
 

A.3.2.2 Printer 
送信するファイルの内容を受信側で印刷するとき設定する。Tiff カラー画像を送信する場合、"Printer"や
"Storage"処理では"PhotometricInterpretation（262）= 6"が一般的に使用される。また圧縮形式についても

Compression（259）= 7 が望ましいが、Compression（259）= 6 も使用される場合がある。"Fax"では RFC3949
の通り"PhotometricInterpretation（262）= 10"が使用されるので、"Fax"と"Storage"または"Printer"とを同時に

"ProcessName"に指定するのは避けた方が良い。 
 

A.3.2.2.1. Color 
能力応答返答値の範囲内で、カラー/白黒印刷を指定する。 
 

A.3.2.2.2. Resolution 
能力応答返答値の範囲内で、印刷解像度を指定する。 

 
A.3.2.2.3. Quality 
能力応答返答値の範囲内で、印刷品質を指定する。 
 

A.3.2.2.4. PaperSize 
能力応答返答値の範囲内で、用紙サイズを指定する。 
 
A.3.2.2.5. Finishings 
能力応答返答値の範囲内で、フィニッシャー処理を指定できる。 
 
A.3.2.2.6. NumberUp 
能力応答返答値の範囲内で、Nin1 を指定する。 
１以上の short（Integer 16 bit）値を使用可能 (1-32767） 

（例． "2" : 2in1 ） 
 

A.3.2.2.7. Orientation 
能力応答返答値の範囲内で、印刷方向を指定する。 
 
A.3.2.2.8. Sides 
能力応答返答値の範囲内で、片面／両面印刷を指定する。
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A.3.2.2.9. Copies 
能力応答の返答値を上限として、送信側機器での印刷出力部数を指定できる。 
１以上の short（Integer 16 bit）値を使用可能 (1-32767） 

（例． "20" : 20 部印刷 ） 

 

A.3.2.2.10. Collate 
能力応答返答値の範囲内で、丁合い印刷指定できる。 
 

A.3.2.2.11. SpecifyCasette 
能力応答返答値を上限として、用紙カセット番号を指定できる。 
正の short（Integer 16 bit）値を使用可能(0-32767）で、指定しない場合は"0"を設定する。 
（例． "3" : カセット番号:３の用紙に印刷出力する ） 

 

A.3.2.2.12. JobPriority 

能力応答返答値を上限として、ジョブ処理優先度を正の整数で指定できる。数字が大きいほど優先度が高い。 
（例． "5" : 優先度:５で印刷処理 ） 

 

A.3.2.3 Fax 
ファクシミリモードでファイル送信する場合に設定する。 
Tiff カラー画像を送信する場合、"Fax"では RFC3949 の通り"PhotometricInterpretation（262）= 10"が使用され

るが、"Storage"や"Printer"の処理では"PhotometricInterpretation（262）= 6"が一般的に使用される。そのため、

"Fax"と"Storage"または"Printer"とを同時に"ProcessName"に指定するのは避けた方が良い。 
 

A.3.2.3.1. TiffType 
能力応答返答値の範囲内で、送信する TIFFType を"S","F","J","C","L","M"から指定する。（参照:RFC3949） 
 
A.3.2.3.2. Resolution 
能力応答返答値の範囲内で、送信する TIFF ファイルの解像度を指定する。 
 

A.3.2.3.3. PaperSize 
能力応答返答値の範囲内で、画像サイズを指定する。 
 

A.3.2.3.4. FcodeSub 
能力応答の"FcodeSupported"が有効なとき F コード SUB (1～20 桁の数字) を指定できる。 
 

A.3.2.3.5. FcodeSid 
能力応答の"FcodeSupported"が有効なとき F コード SID (1～20 桁の数字) を指定できる。 
 

A.3.2.4 "ProprietaryMode" 
"ProprietaryMode"を設定する場合、その中の Arguments は自由に独自拡張して定義・設定して良い。 
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A.3.3 AnnexA ジョブ開始応答（CreateJobResponse） 追加オプション 
ジョブ生成フェーズにおいて、ジョブ開始応答（本編 10.3.4 項 及び 9.7 項 シーケンス F34,F42 参照）に追

加設定できるオプションのタグを表A.7 に規定する。 
 

表 A- 7／TR-1038 AnnexA ジョブ開始応答（CreateJobResponse） 追加オプション 
変数 M/O 内容 

 <Options> M 拡張用 
  <cta:ResponseList> O  
   <cta:Response> M  
    <ProcessName> M 送信側から指定された処理メソッド名を設定 
    <Status> M 処理メソッドのステータスを設定 
    <Reason> O ステータスの理由を設定 

※「M」=必須、「O」=オプション 

 

 

A.3.3.1 <cta:Response> 
<cta:Response>は子要素の<ProcessName>により識別される。 
CreateJob における<cta:Request>１つに対して、<CreateJobResponse>における<cta:Response>タグ１つを設定

する。 
CreateJob の<cta:Request>で<ProcessName>が指定された場合、解釈できない場合も必ず<Status>を付けた

<cta:Response>を返すこと。 
<cta:Request>が複数ある場合、それぞれの<cta:Request>に対して同じ<ProcessName>を<cta:Response>に設定

することにより、<cta:Request>と<cta:Response>の１対１の対応関係になるようにすること。また、

<cta:Response>を複数設定する場合には、受信した CreateJob の中に現れる<cta:Request>と同じ順番で、

<CreateJobResponse>の<cta:ResponseList>の子要素に設定すること。 
 

A.3.3.2 <ProcessName> 
送信側が指定してきた処理メソッド名を設定する。 
 

A.3.3.3 <Status> 
<ProcessName>ごとに、処理メソッドを受け入れるかどうかを設定する。 
 

A.3.3.4 <Reason> 
<Status>に示す状況に至った原因等を設定する。 
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A.3.4 AnnexA ジョブ開始応答  ProcessName/Status 定義 
ジョブ開始応答を行うとき、A.3.3 項の<ProcessName>とArgumentsの<Status>各タグに設定する値を 表A- 8
に規定し、<Reason>については A.3.5 項に規定する。 
 

表 A- 8／TR-1038 AnnexA ジョブ開始応答  ProcessName/Status 定義 
ProcessName Status Reason 成否 内容 

Storage    
 Accepted 不要 成功 受信するファイルをサーバ等に保存する 
 Rejected A.3.5項 参照 失敗 受信するファイルをサーバ等に保存しない

Printer    
 Accepted 不要 成功 受信するファイルの印刷要求を受け容れる

 Rejected A.3.5項参照 失敗 受信するファイルの印刷要求を受け容れな

い 
 FileReceiveOnly 不要 成功 印刷要求を受け容れないが、受信は行って

ファイルをサーバ等に保存する場合 
Fax    
 Accepted 不要 成功 ファクシミリモードでファイル受信する 
 Rejected A.3.5項参照 失敗 ファクシミリモードでファイル受信しない

ProprietaryMode 独自定義 独自定義  自由に独自拡張して定義・設定する 

 
 

A.3.5 AnnexA ジョブ開始応答  Reason 定義 
 

表 A- 9／TR-1038 AnnexA ジョブ開始応答  Reason 定義 
適用Status Reason:設定値 成否 設定条件 

Rejected Unrecognized 失敗 要求されたProcessNameが認識出来ず、Requestを拒否

する場合 
Rejected NotImplemented 失敗 要求されたProcessNameを認識出来るが、処理が未実装

でRequestを拒否する場合 
Rejected NotAvailable 失敗 要求されたProcessNameが一時的に受信処理出来ない

が、時間経過後に復帰して再受信が見込める場合 
Rejected InvalidArguments 失敗 指定したArgumentsを認識できない場合、内容に誤りが

ある場合 
Rejected StorageFull 失敗 記憶領域が不足し、要求された受信処理が出来ない場

合(回復が見込める場合は" NotAvailable"を返す) 

※ ジョブ開始応答は<ProcessName>ごとに異なる値を返すので、"Rejected"以外の応答が 1 個でもある場

合、10.3.4 項の<ct:JobID>にはエラーコードでは無く正の値のジョブ識別子を設定すること。 
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A.4 XML メッセージ例 

A.4.1 能力確認要求／応答 XML メッセージ例 
 

A.4.1.1 F16 CapabilityName を指定しないで能力確認要求する例 

 
 

<?xml version="1.0" encoding="UTF-8"?> 

<env:Envelope xmlns:env="http://www.w3.org/2003/05/soap-envelope" xmlns:ct="http://www.ttc.or.jp/mmsys/ct">

  <env:Body> 

    <ct: GetCapability> 

      <Options /> 

    </ct: GetCapability> 

  </env:Body> 

</env:Envelope> 
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A.4.1.2 F17 前記能力確認要求への能力確認応答例 

 

注） 
・A.4.1.1 項にてCapabilityNameを指定しない能力確認を要求されたので、受信機器で実装された全機能の

能力を応答する。 
 

<?xml version="1.0" encoding=" UTF-8"?> 

<env:Envelope xmlns:env="http://www.w3.org/2003/05/soap-envelope" xmlns:ct="http://www.ttc.or.jp/mmsys/ct" 

xmlns:cta="http://www.ttc.or.jp/mmsys/ct/cta"> 

  <env:Body> 

    <ct:GetCapabilityResponse> 

      <ct:SupportedFormats>image/jpg,image/tiff,!application/*</ct:SupportedFormats> 

      <Options> 

        <cta:TerminalIdentification>OfficeXXX@YYY_CORPORATION</cta:TerminalIdentification> 

        <cta:Password>password_txt</cta:Password> 

        <cta:CapabilityList> 

          <cta:Capability> 

            <CapabilityName>Storage</CapabilityName> 

            <ArgumentsList> 

              <Argument> 

                  <Name>Parameter_Name_A1</Name> 

                  <Value>Parameter_Value_A1</Value> 

              </Argument> 

              <Argument> 

                  <Name>Parameter_Name_A2</Name> 

                  <Value>Parameter_Value_A2</Value> 

              </Argument> 

            </ArgumentsList> 

          </cta:Capability> 

          <cta:Capability> 

            <CapabilityName>Printer</CapabilityName> 

            <ArgumentsList> 

              <Argument> 

                  <Name>Parameter_Name_B3</Name> 

                  <Value>Parameter_Value_B3</Value> 

              </Argument> 

            </ArgumentsList> 

          </cta:Capability> 

        </cta:CapabilityList> 

      </Options> 

    </ct:GetCapabilityResponse> 

  </env:Body> 

</env:Envelope> 
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A.4.1.3 F16 受信側同一機器に CapabilityName に"Printer","Fax"を指定した能力確認要求例 

 
 

<?xml version="1.0" encoding=" UTF-8"?> 

<env:Envelope xmlns:env="http://www.w3.org/2003/05/soap-envelope" xmlns:ct="http://www.ttc.or.jp/mmsys/ct" 

xmlns:cta="http://www.ttc.or.jp/mmsys/ct/cta"> 

  <env:Body> 

    <ct:GetCapability> 

      <Options> 

        <cta:TerminalIdentification>OfficeXXX@YYY_CORPORATION</cta:TerminalIdentification> 

        <cta:Password>password_txt</cta:Password> 

        <cta:CapabilityList> 

          <cta:Capability> 

            <CapabilityName>Printer</CapabilityName> 

          </cta:Capability> 

          <cta:Capability> 

            <CapabilityName>Fax</CapabilityName> 

            <ArgumentsList> 

              <Argument> 

                  <Name>Parameter_Name_C4</Name> 

                  <Value>Parameter_Value_C4</Value> 

              </Argument> 

            </ArgumentsList> 

          </cta:Capability> 

        </cta:CapabilityList> 

      </Options> 

    </ct:GetCapability> 

  </env:Body> 

</env:Envelope> 
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A.4.1.4 F17 前記能力確認要求への能力確認応答例 

 

 

注） 
・A.4.1.2 項の応答で返した内容を、受信側の機器で実装された全機能（能力）とする。 
・A.4.1.3 項の能力要求で存在しないCapabilityName:"Fax"の能力を要求されたが、実装されていないので

中味の無い応答を返す。 
・A.4.1.3 項の能力要求で指定されなかったCapabilityName:"Storage"の能力は、実装されていても返さな

い。 
 

A.4.2 ジョブ開始要求／応答 XML メッセージ例 

<?xml version="1.0" encoding=" UTF-8"?> 

<env:Envelope xmlns:env="http://www.w3.org/2003/05/soap-envelope" xmlns:ct="http://www.ttc.or.jp/mmsys/ct" 

xmlns:cta="http://www.ttc.or.jp/mmsys/ct/cta"> 

  <env:Body> 

    <ct:GetCapabilityResponse> 

      <ct:SupportedFormats>image/jpg,image/tiff,!application/*</ct:SupportedFormats> 

      <Options> 

        <cta:TerminalIdentification>OfficeXXX@YYY_CORPORATION</cta:TerminalIdentification> 

        <cta:Password>password_txt</cta:Password> 

        <cta:CapabilityList> 

          <cta:Capability> 

            <CapabilityName>Printer</CapabilityName> 

            <ArgumentsList> 

              <Argument> 

                  <Name>Parameter_Name_B3</Name> 

                  <Value>Parameter_Value_B3</Value> 

              </Argument> 

            </ArgumentsList> 

          </cta:Capability> 

          <cta:Capability> 

            <CapabilityName>Fax</CapabilityName> 

          </cta:Capability> 

        </cta:CapabilityList> 

      </Options> 

    </ct:GetCapabilityResponse> 

  </env:Body> 

</env:Envelope> 
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A.4.2.1 F18 ジョブ開始要求例 

<?xml version="1.0" encoding=" UTF-8"?> 

<env:Envelope xmlns:env="http://www.w3.org/2003/05/soap-envelope" xmlns:ct="http://www.ttc.or.jp/mmsys/ct" 

xmlns:cta="http://www.ttc.or.jp/mmsys/ct/cta"> 

  <env:Body> 

    <ct:CreateJob> 

      <ct:ContentName>DocumetABC.tiff</ct:ContentName> 

      <ct:ContentSize>546800</ct:ContentSize> 

      <ct:Format>image/tiff</ct:Format> 

      <Options> 

        <cta:Title> DocumetABC </cta:Title> 

        <cta:Descriptions>Software Design Specification </cta:Descriptions> 

        <cta:Hash > 

          <Algorithm>MD5</Algorithm> 

          <Value>2f22abac3734edbf3327a96e8fa9a18b</Value> 

        </cta:Hash > 

        <cta:RequestList> 

          <cta:Request reqId="1639"> 

            <ProcessName>Storage</ProcessName> 

          </cta:Request> 

          <cta:Request reqId="1640"> 

            <ProcessName>Printer</ProcessName> 

          </cta:Request> 

          <cta:Request reqId="1641"> 

            <ProcessName>Fax</ProcessName> 

          </cta:Request> 

          <cta:Request reqId="1642"> 

            <ProcessName>Proprietary</ProcessName> 

            <ArgumentsList> 

              <Argument> 

                  <Name>Parameter_Name_ZZ5</Name> 

                  <Value>Parameter_Value_ZZ5</Value> 

              </Argument> 

              <Argument> 

                  <Name>Parameter_Name_ZZ6</Name> 

                  <Value>Parameter_Value_ZZ6</Value> 

              </Argument> 

            </ArgumentsList> 

          </cta:Request> 

        </cta:RequestList> 

      </Options> 

    </ct:CreateJob> 

  </env:Body> 

</env:Envelope> 
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A.4.2.2 F19 ジョブ開始応答例 

 

<?xml version="1.0" encoding=" UTF-8"?> 

<env:Envelope xmlns:env="http://www.w3.org/2003/05/soap-envelope" xmlns:ct="http://www.ttc.or.jp/mmsys/ct" 

xmlns:cta="http://www.ttc.or.jp/mmsys/ct/cta"> 

  <env:Body> 

    <ct:CreateJobResponse> 

      <ct:JobID>123456</ct:JobID> 

      <ct:Path>/20090803/</ct:Path> 

      <Options> 

        <cta:ResponseList> 

          <cta:Response reqId="1639"> 

            <ProcessName>Storage</ProcessName> 

            <Status>Accepted</Status> 

          </cta:Response> 

          <cta:Response reqId="1640"> 

            <ProcessName>Printer</ProcessName> 

            <Status>FileReceiveOnly</Status> 

          </cta:Response> 

          <cta:Response reqId="1641"> 

            <ProcessName>Fax</ProcessName> 

            <Status>Rejected</Status> 

            <Reason>Unrecognized</Reason> 

          </cta:Response> 

          <cta:Response reqId="1642"> 

            <ProcessName>Proprietary</ProcessName> 

            <Status>Rejected</Status> 

            <Reason>NotImplemented</Reason> 

          </cta:Response> 

        </cta:ResponseList> 

      </Options> 

    </ct:CreateJobResponse> 

  </env:Body> 

</env:Envelope> 
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A.5 AnnexA  スキーマ 

<?xml version="1.0" encoding="UTF-8"?> 

<xs:schema xmlns:xs="http://www.w3.org/2001/XMLSchema" 

xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 

  targetNamespace="http://www.ttc.or.jp/mmsys/ct/cta" xmlns:cta="http://www.ttc.or.jp/mmsys/ct/cta" 

  elementFormDefault="unqualified" attributeFormDefault="unqualified"> 

 

  <xs:element name="CapabilityList"> 

    <xs:complexType> 

      <xs:sequence maxOccurs="unbounded"> 

        <xs:element ref="cta:Capability" /> 

      </xs:sequence> 

    </xs:complexType> 

  </xs:element> 

 

  <xs:element name="Capability"> 

    <xs:complexType> 

      <xs:sequence> 

        <xs:element type="cta:ProcessNameType" name="CapabilityName" /> 

        <xs:element name="ArgumentsList" minOccurs="0"> 

          <xs:complexType> 

            <xs:sequence maxOccurs="unbounded"> 

              <xs:element name="Argument"> 

                <xs:complexType> 

                  <xs:sequence> 

                    <xs:element type="xs:string" name="Name" /> 

                    <xs:element type="xs:string" name="Value" /> 

                  </xs:sequence> 

                </xs:complexType> 

              </xs:element> 

            </xs:sequence> 

          </xs:complexType> 

        </xs:element> 

      </xs:sequence> 

    </xs:complexType> 

  </xs:element> 

 

  <xs:simpleType name="ProcessNameType"> 

    <xs:restriction base="xs:string"> 

      <xs:enumeration value="Storage" /> 

      <xs:enumeration value="Printer" /> 

      <xs:enumeration value="Fax" /> 

      <xs:enumeration value="Proprietary" /> 
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      <xs:enumeration value=" RemoteMaintenanceCapability" /> 

      <xs:enumeration value=" StatusCapabilityDetail " /> 

      <xs:enumeration value="Proprietary" /> 

    </xs:restriction> 

  </xs:simpleType> 

 

  <xs:element type="xs:string" name="TerminalIdentification" /> 

   

  <xs:element type="xs:string" name="Password" /> 

 

  <xs:element name="Title" type="xs:string" /> 

 

  <xs:element name="Descriptions" type="xs:string" /> 

 

  <xs:element name="Hash"> 

    <xs:complexType> 

      <xs:sequence> 

        <xs:element name="Algorithm"> 

          <xs:simpleType> 

            <xs:restriction base="xs:string"> 

              <xs:enumeration value="MD5" /> 

              <xs:enumeration value="SHA-1" /> 

            </xs:restriction> 

          </xs:simpleType> 

        </xs:element> 

        <xs:element name="Value" type="xs:string" /> 

      </xs:sequence> 

    </xs:complexType> 

  </xs:element> 

 

  <xs:element name="RequestList"> 

    <xs:complexType> 

      <xs:sequence maxOccurs="unbounded"> 

        <xs:element ref="cta:Request" /> 

      </xs:sequence> 

    </xs:complexType> 

  </xs:element> 

 

  <xs:element name="Request"> 

    <xs:complexType> 

      <xs:sequence> 

        <xs:element type="cta:ProcessNameType" name="ProcessName" /> 

        <xs:element name="ArgumentsList" minOccurs="0"> 
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          <xs:complexType> 

            <xs:sequence maxOccurs="unbounded"> 

              <xs:element name="Argument"> 

                <xs:complexType> 

                  <xs:sequence> 

                    <xs:element type="xs:string" name="Name" /> 

                    <xs:element type="xs:string" name="Value" /> 

                  </xs:sequence> 

                </xs:complexType> 

              </xs:element> 

            </xs:sequence> 

          </xs:complexType> 

        </xs:element> 

      </xs:sequence> 

      <xs:attribute type="xs:nonNegativeInteger" name="reqId" /> 

    </xs:complexType> 

  </xs:element> 

 

  <xs:element name="ResponseList"> 

    <xs:complexType> 

      <xs:sequence maxOccurs="unbounded"> 

        <xs:element ref="cta:Response" /> 

      </xs:sequence> 

    </xs:complexType> 

  </xs:element> 

 

  <xs:element name="Response"> 

    <xs:complexType> 

      <xs:sequence> 

        <xs:element type="cta:ProcessNameType" name="ProcessName" /> 

        <xs:element name="Status"> 

          <xs:simpleType> 

            <xs:restriction base="xs:string"> 

              <xs:enumeration value="Accepted" /> 

              <xs:enumeration value="Rejected" /> 

              <xs:enumeration value="FileReceiveOnly" /> 

            </xs:restriction> 

          </xs:simpleType> 

        </xs:element> 

        <xs:element name="Reason" minOccurs="0"> 

          <xs:simpleType> 

            <xs:restriction base="xs:string"> 

              <xs:enumeration value="Unrecognized" /> 
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              <xs:enumeration value="NotImplemented" /> 

              <xs:enumeration value="NotAvailable" /> 

              <xs:enumeration value="InvalidArguments" /> 

              <xs:enumeration value="StorageFull" /> 

            </xs:restriction> 

          </xs:simpleType> 

        </xs:element> 

      </xs:sequence> 

      <xs:attribute type="xs:nonNegativeInteger" name="reqId" /> 

    </xs:complexType> 

  </xs:element> 

 

</xs:schema> 
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付属資料B AnnexB リモートメンテナンス機能のためのネゴシエーション方法 

 

本付属資料の適用範囲は、本編のコンテンツ転送手順（接続形態２、接続形態３）を用いて状態情報データ

送受信を行う際の信号定義について記述する。本 AnnexB 内で設定した、コマンド指示用 TextData (B.4 参

照)を、機器の状態情報の詳細として、新たなコンテンツとして定義しており、そのコンテンツの配信を行

う事で、機器のリモートメンテナンスを実現する。更に、追加のコンテンツの配信を行う事で、リモート

メンテナンスの性能向上を実現すると可能としてる。 

機器のリモートメンテナンスの主要機能として、以下の３つの事例を具体的なシーケンスとして示した。 

 

１．機器からの定期的な、利用状況の配信。(B.5.1 参照) 

２．機器の利用状況を管理するセンターマシンからの要求による、利用状況の配信。(B5.2 参照) 

３．「１」の情報配信を受けて、センターマシンからの追加のコンテンツ配信による、機器の問題点を解除

する手法を告知する利用。（B5.3 参照） 

 

本定義による基本機能を、複数の製品でサポートすることで、共通化されたリモートメンテナンス機能に

より、基本の機器状態を１つのアプリケーション（サーバーソフト）で集約可能にし、リモートメンテナン

ス機能が、1 対 1 社（1 センターマシン対 1 社製造機器）ではなく、1 対複数社センターマシン対複数社製

造機器）で拡張できることを意識して定義する。本定義により、同一企業に異なるメーカーの機器が、設置

されている場合においても、リモートメンテナンス機能の統一性を確保する。共通部分を、以下に規定す

る。 

今回は、機器とセンターマシン間での通信機能を定義する、 
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B.1 SIP/SDP 様式 

本編 8.1 項に従う。 

 

B.2 能力通知様式 

能力確認フェーズ 追加オプションを記載 

 

B.2.1 AnnexB 能力確認要求（GetCapability） 追加オプション 
能力確認フェーズにおいて、能力確認要求（本編 10.2.2 項 及び 9.7 項 シーケンス F29 参照）に追加設定

できるオプションのタグを表B- 1 に規定する。 

 

表 B- 1／TR-1038 AnnexB 能力確認要求（GetCapability） 追加オプション 

変数 M/O 内容 

 <Options> M 拡張用 

  <cta:TerminalIdentification> O 機器に設定された名称 

  <cta:Password> O パスワードを設定 

  <cta:CapabilityList> O  

   <cta:Capability> M  

    <CapabilityName> M 能力応答する機能名を設定 

    <ArgumentsList> O  

     <Argument> M  

      <Name> M 引数名の設定 

      <Value> M 引数の値を設定 

※「M」=必須、「O」=オプション 

 

B.2.1.1 <Options> 
<Options>を設定しないで能力確認要求が行われた場合、受信側は全機能の能力確認応答を返すこと。送信

側機器の実装機能が限定されていて不要な能力応答を受け取りたくない場合、<cta:CapabilityList>以下

<CapabilityName>で能力確認機能を指定して必要機能のみの能力応答を受け取ることが出来る。 
注）<Options>タグは子要素が空きかそうでないかにかかわらず必ず設定すること。 
 
B.2.1.2 <cta:TerminalIdentification> 

<cta:TerminalIdentification>タグは、能力確認要求において送信側機器の名称を通知する際に使用する。 受

信側機器では、能力確認要求に含まれる<cta:TerminalIdentification>から送信側機器を判断し、応答の要否や

能力確認応答の返信内容を変更することが出来る。（広告・スパム等の受信防止） 

 

B.2.1.3 <cta:Password> 

パスワードを設定。今回は詳細規定しない。 
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B.2.1.4 <cta:Capability> 

<cta:Capability>は子要素の<CapabilityName>により識別される。 

<cta:CapabilityList>の子要素には最低一つの<cta:Capability>を設定すること。<cta:CapabilityList>の子要素とし

て、２つ以上の<cta:Capability>を設定可能とするが、同内容の<CapabilityName>を含む<cta:Capability>を複数

設定しないこと。 

 

B.2.1.5 <CapabilityName> 
能力確認を要求する機能名を指定するとき、 <cta:CapabilityList> と <cta:Capability> とを使用して

<CapabilityName>に機能名を設定する。AnnexBでは B.2.2 項に定義された機能名を設定できる。複数個設定

する場合は、<cta:Capability>以下を複数回記述し、また別Annexの機能名と混在しての設定もできる。 
 

B.2.1.6 <Name> 、<Value> 

機能別に能力確認を要求する際、<ArgumentsList>、<Argument>を使って<CapabilityName>毎に受信側に引数

を通知することができる。 

 

B.2.2 AnnexB 能力確認要求  CapabilityName/Arguments 定義 
能力確認要求を行うとき、B.2.1 項の<CapabilityName>とArgumentsの<Name>各タグに設定する値を 表B- 2
に規定し、<Name>に対応する<Value>設定値を項目ごとに B.2.2.1 項以降に規定する。 
 

表 B- 2／TR-1038 AnnexB 能力確認要求  CapabilityName/Arguments 定義 
CapabilityName ArgumentのName M/O 内容 

RemoteMaintenanceC
apability 

 O RemoteMaintenanceCapabilityに関する能力を要求 

StatusCapabilityDetail  O StatusCapabilityDetailに関する能力を要求 
CommandCapabilityD
etail 

 O CommandCapabilityDetailに関する能力を要求 

※「M」=必須、「O」=オプション  

 

B.2.2.1 RemoteMaintenanceCapability 
リモートメンテナンス機能に関する能力を設定する 

 

B.2.2.2 StatusCapabilityDetail 
状態情報の通知能力を設定する。 

 

B.2.2.3 CommandCapabilityDetail 
コマンド指示の実行に関する能力を設定する。 
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B.2.3 AnnexＢ能力確認応答（GetCapabilityResponse） 追加オプション 

能力確認フェーズにおいて、能力確認応答に追加設定できるオプションのタグを規定する。 

 

表 B- 3／TR-1038 AnnexB 能力確認応答（GetCapabilityResponse） 追加オプション 
変数 M/O 内容 

 <Options> M 拡張用 

  <cta:TerminalIdentification> O 機器に設定された名称 

  <cta:Password> O パスワードを設定 

  <cta:CapabilityList> O  

   <cta:Capability> M  

    <CapabilityName> M 能力応答する機能名を設定 

    <ArgumentsList> O  

     <Argument> M  

      <Name> M 引数名の設定 

      <Value> M 引数の値を設定 

※「M」=必須、「O」=オプション 

 

B.2.3.1 <Options> 
1 つ以上の機能について能力確認応答を返す場合に設定すること。送信側が機能名を指定して能力確認を要

求し、かつ指定された機能名が受信側で未実装の場合、受信側は<CapabilityName>に機能名を設定した

<ArgumentsList>以降が空の能力確認応答を返すこと。送信側で機能名を指定せず<Options>以下が空の能力

確認を要求した場合、受信側は実装された機能名について応答可能な全ての能力確認応答を返すこと。解釈

できない機能名・引数等の変数が送信側から通知された場合、受信側は解釈できるもののみ解釈し、解釈で

きないものは無視すること。 
注）<Options>タグは子要素が空きかそうでないかにかかわらず必ず設定すること。 
 

B.2.3.2 <cta:TerminalIdentification> 
<cta:TerminalIdentification>タグは、能力確認応答において受信側機器に設定された名称を通知する際に使用

する。 意図した接続先に正しく接続されたか（誤接続防止）、能力確認要求側が判断するのに使用でき

る。 
 

B.2.3.3 <cta:Password> 

パスワードを設定。今回は詳細規定しない。 
 

B.2.3.4 <cta:Capability> 
<cta:Capability>は子要素の<CapabilityName>により識別される。 
GetCapability における<cta:Capability>1 つに対して、<GetCapabilityResponse>における<cta:Capability>タグ 1
つを設定する。<cta:Capability>が複数ある場合、それぞれの<cta:Capability>に対して同じ<CapabilityName>
を<cta:Capability>に設定することにより、GetCapability における<cta:Capability>と<GetCapabilityResponse>に
おける<cta:Capability>の 1 対 1 の対応関係になるようにすること。 
また、<cta:Capability>を複数設定する場合には、受信した GetCapability の中に現れる<cta:Capability>と同じ

順番で、<GetCapabilityResponse>の<cta:CapabilityList>の子要素に設定すること。 
 

B.2.3.5 <CapabilityName> 
能力確認に応答するとき、<cta:CapabilityList>と<cta:Capability>とを使用して<CapabilityName>に機能名を設

定する。AnnexBでは B.2.4 項に定義された機能名と詳細な引数を設定できる。複数個設定する場合は、

<cta:Capability>以下を複数回記述し、また別Annexの機能名と混在しての設定もできる。 
 

B.2.3.6 <Name> 、<Value> 

機能別の能力確認応答を返す際、<ArgumentsList>、<Argument>を使って<CapabilityName>毎に実装された能

力の詳細を引数に設定して送信側に通知できる。 
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B.2.4 AnnexB 能力確認応答  CapabilityName/Arguments 定義 
能力確認応答を行うとき、B.2.3 項の<CapabilityName>と<Arguments>の<Name>各タグに設定する値を表B- 4
に規定し、<Name>に対応する<Value>設定値を項目ごとに B.2.4.1 項以降に規定する。 

 

表 B- 4／TR-1038 AnnexB 能力確認応答  CapabilityName/Arguments 定義 
CapabilityName ArgumentのName M/O 内容 

<RemoteMaintenance
Capability> 

 O RemoteMaintenanceCapabilityに関する能力を

要求 
 <SupportedFormats> M 対応コンテンツフォーマット 
 <StatusCapability> M 機器の状態情報を告知対応可否 
 <CommandCapability> M リモートでの指示コマンドへの対応能力の有

無 
 <ResponseLevelOfCenter

Machine> 
M センターマシンの名称に応じた機器側の応答

レベルを設定する 
<StatusCapabilityDet
ail> 

 O StatusCapabilityDetailに関する能力を要求 

 <FailCounter> M 過去不良回数 
 <ConsumptionCounter> M 消耗品使用状態 
 <StatusFormat> M 告知フォーマット 
<CommandCapability
Detail> 

 O CommandCapabilityDetailに関する能力を要求

 <CommandResponse> M 応答の為のコマンド対応 
 <CommandActivate> M 機器の動作を伴うコマンド対応 

※「M」=必須、「O」=オプション 
 

B.2.4.1 <RemoteMaintenanceCapability> 

リモートメンテナンス機能に関連した能力を規定する。 

 

B.2.4.1.1. <SupportedFormats> 

機器の状態に応じて、様々な指示を行うセンターマシンからのコンテンツ転送の形で実施する場合に、機器

側で、処理可能なフォーマットを規定する。 

各種書式:動画、音声、静止画、TextData、その他 を大項目共通項目として規定し、詳細は、コロンで区切

り、対応処理をカンマ","で区切って設定する。各項目の下部に設定 

http://www.iana.org/assignments/media-types/ を参照。（本編 10.3.2.1 項参照） 
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B.2.4.1.2. <StatusCapability> 

機器が応答可能な、状態情報通知の能力を規定する。ここでは、通知可能、不可能を規定する。 

"Supported"  : 状態情報通知をサポートしていることを示す。 

"NotSupported"   : 状態情報通知をサポートしていないことを示す。 

 

B.2.4.1.3. <CommandCapability> 

センターマシンからリモートで行う、指示コマンドに対する対応能力を規定する。 

ここでは、対応可能、不可能を規定する。 

"Supported"  : 指示コマンドをサポートしていることを示す。 

"NotSupported"  : 指示コマンドをサポートしていないことを示す。 

 

B.2.4.1.4. <ResponseLevelOfCenterMachine> 

センターマシンの名称により、機器側の応答レベルを、センターマシンに返送する為に用いる。 

これらの応答レベルは、あらかじめ機器内部に設定しておく必要がある。 

"FullSupported"  : センターマシンからの、状態情報要求、各種カウンター情報要求、各種設定 

項目の反映要求に全て応答できることを示す。 

"SupportA" : センターマシンからの、状態情報要求、各種カウンター情報要求に全て 

応答できることを示す。 

"SupportB"  : センターマシンからの、状態情報要求に応答できることを示す。 

"NotSupported"  : センターマシンからの、要求に対して一切、応答できないことを示す。 

 

B.2.4.2 <StatusCapabilityDetail> 

機器の状態の通知内容に関する詳細能力を規定する。 

 

B.2.4.2.1. <FailCounter> 

過去発生の致命的エラー、用紙ジャムエラー等の発生回数の通知能力の有無を応答する。 

"Supported"  : 各種エラーの発生回数の応答をサポートしていることを示す。 

"NotSupported"  : 各種エラーの発生回数の応答をサポートしていないことを示す。 

 

B.2.4.2.2. <ConsumptionCounter> 

機器に使用されている消耗品に関する使用回数（枚数）の通知能力の有無を応答する。 

"Supported"  : 各種消耗品の使用回数（枚数）の応答をサポートしていることを示す。 

"NotSupported"  : 各種消耗品の使用回数（枚数）の応答をサポートしていないことを示す。 
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B.2.4.2.3. <StatusFormat> 

各状態情報の通知の書式を規定する。以下のいずれかの方法で、規定することができる。混在はできない。 

(1) String にて、カウンター、機器状態の内容を記載し、値・状態を表す方法 

(2) MIB 書式による、値・状態を表す方法 

 

B.2.4.2.4. <CommandResponse> 

センターマシンからの各種のカウンター情報・状態情報等の通知要求に返送する能力を規定する。 

"Supported"  : 各種カウンター情報・状態情報の応答をサポートしていることを示す。 

"NotSupported"  : 各種カウンター情報・状態情報の応答をサポートしていないことを示す。 

 

B.2.4.2.5. <CommandActivate> 

センターマシンからのリモートの指示コマンドで、機器の各種設定項目の反映、指示コマンドの機器での実

行能力を規定する。 

"Supported"  : 指示コマンドの機器での実行をサポートしていることを示す。 

"NotSupported"  : 指示コマンドの機器での実行をサポートしていないことを示す。 
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B.3 ジョブ開始通知様式 

B.3.1 AnnexB ジョブ開始要求（CreateJob） 追加オプション 
ジョブ生成フェーズにおいて、ジョブ開始要求（本編 10.2.4 項 及び 9.7 項 シーケンス F33,F41 参照）に追

加設定できるオプションのタグを表B- 5 に規定する。 
 

表 B- 5／TR-1038 AnnexB ジョブ開始要求（CreateJob） 追加オプション 
変数 M/O 内容 

 <Options> M 拡張用 

  <cta:RequestList> M  

   <cta:Request> M  

    <ProcessName> M 送信するファイルに対する受信側の処理メソッドを

設定 

    <ArgumentsList> O  

     <Argument> M  

      <Name> M 受信側の処理メソッドの引数名を設定 

      <Value> M 受信側の処理メソッドの引数の値を設定 

※「M」=必須、「O」=オプション  

 

B.3.1.1 <Options> 
AnnexB の能力を指定してジョブ開始要求を行う場合は<ProcessName>を必ず設定する。 
注）<Options>タグは子要素が空きかそうでないかにかかわらず必ず設定すること。 

 

B.3.1.2 <ProcessName> 
送信するファイルに対する受信側の処理メソッドを設定する。AnnexBでは B.3.2 項に定義された

ProcessName 及び Arguments を<cta:RequestList>と<cta:Request>とを使用して<ProcessName>に設定する。

送信するファイル 1 つに対して、同時に複数の処理を要求できる。 
 

B.3.1.3 <Name> 
受信側の処理メソッドの引数名を設定する。 

 

B.3.1.4 <Value> 
受信側の処理メソッドの引数の値を設定する。 
 

B.3.2 AnnexB ジョブ開始要求  ProcessName/Arguments 定義 
ジョブ開始要求を行うとき、B.3.1項の<ProcessName>とArgumentsの<Name>各タグに設定する値を表B- 6に
規定する。 
 

表 B- 6／TR-1038 AnnexB ジョブ開始要求  ProcessName/Arguments 定義 
ProcessName Argument M/O 内容 

RemoteMaintenanceCapabili
ty 

 O RemoteMaintenanceCapabilityに関する能力を

要求 
StatusCapabilityDetail  O StatusCapabilityDetailに関する能力を要求 
CommandCapabilityDetail  O CommandCapabilityDetailに関する能力を要求

※「M」=必須、「O」=オプション  

 



ＴＲ－１０３８ - 100 - 

 

B.3.3 AnnexB ジョブ開始応答（CreateJobResponse） 追加オプション 
ジョブ生成フェーズにおいて、ジョブ開始応答（本編 10.3.4 項 及び 9.7 シーケンス例 F34,F42 参照）に追

加設定できるオプションのタグを表B- 7 に規定する。 
 

表 B- 7／TR-1038 AnnexB ジョブ開始応答（CreateJobResponse） 追加オプション 
変数 M/O 内容 

 <Options> M 拡張用 
  <cta:ResponseList> O  
   <cta:Response> M  
    <ProcessName> M 送信側から指定された処理メソッド名を設定 
    <Status> M 処理メソッドのステータスを設定 
    <Reason> O ステータスの理由を設定 

※「M」=必須、「O」=オプション 

 

B.3.3.1 <cta:Response> 
<cta:Response>は子要素の<ProcessName>により識別される。 
CreateJob における<cta:Request>１つに対して、<CreateJobResponse>における<cta:Response>タグ１つを設定

する。 
CreateJob の<cta:Request>で<ProcessName>が指定された場合、解釈できない場合も必ず<Status>を付けた

<cta:Response>を返すこと。 
<cta:Request>が複数ある場合、それぞれの<cta:Request>に対して同じ<ProcessName>を<cta:Response>に設定

することにより、<cta:Request>と<cta:Response>の１対１の対応関係になるようにすること。また、

<cta:Response>を複数設定する場合には、受信した CreateJob の中に現れる<cta:Request>と同じ順番で、

<CreateJobResponse>の<cta:ResponseList>の子要素に設定すること。 
 

B.3.3.2 <ProcessName> 
送信側が指定してきた処理メソッド名を設定する。 
 

B.3.3.3 <Status> 
<ProcessName>ごとに、処理メソッドを受け入れるかどうかを設定する。 
 

B.3.3.4 <Reason> 
<Status>に示す状況に至った原因等を設定する。 
 
 
 



ＴＲ－１０３８ - 101 - 

 

B.3.4 AnnexB ジョブ開始応答  ProcessName/Status 定義 
ジョブ開始応答を行うとき、B.3.2の<ProcessName>とArgumentsの<Status>各タグに設定する値を表B- 8に規

定する。本応答が実施される事により、AnnexB状態での動作中である事を示す。 
 

表 B- 8／TR-1038 AnnexB ジョブ開始応答  ProcessName/Status 定義 
ProcessName Status Reason 成否 内容 

RemoteMaintena
nceCapability 

   

 Accepted － 成功 リモートメンテナンス機能に対応 
 Rejected － 失敗 リモートメンテナンス機能に対応しない 
StatusCapability
Detail 

   

 Accepted － 成功 機器の状態情報発信に対応 
 Rejected － 失敗 機器の状態情報発信に対応しない 
CommandCapab
ilityDetail 

   

 Accepted － 成功 コマンド指示に対応 
 Rejected － 失敗 コマンド指示に対応しない 

 

B.4 コマンド指示用 TextData 

機器のリモートメンテナンス機能において、センターマシンから機器に対してコマンド指示の形で、各種

の情報・設定反映等を要求するケースが出て来る。これらを、コンテンツ転送機能の、TextData の転送に

よりその指示内容及び、その結果応答を表すことで、コマンド指示機能を達成する。この対応により、

SOAP/HTTP 以外のプロトコルを使うことなく、機器へのコマンド指示を可能にする。 

機器は、MIB による状態情報の通信を行う機能が、一般的に搭載されている。この機能を有効に使い、MIB

による一括の状態情報要求、及び一括応答を可能にする。 

共通項目として、設定される MIB は、以下の 3 種類を定義する。 

 

１．MIBⅡ(RFC1213),  

２．HostResourceMIB (RFC2790),  

３．Printer MIB (RFC3805),  

 

B.4.1 基本書式指示 (センターマシンから機器へ) 

状態情報コマンド指示フェーズで、使われる TextData として、書式を定義する。 

必ず、センターマシンから、機器へ送信される為、状態情報コマンド指示フェーズで、扱われる。 

拡張子:「.txt」ファイル:ASN.1 表記で定義し、RFC3641 に準拠すること 

コマンド指示の内容は、大きく分けて 3 種類が存在する。 

 

① 特定の回数、状態の応答を指示するコマンド。 

② 特定の設定の反映、機器での実行項目を指示するコマンド。 

③ 特定の別コンテンツファイルの送付と連動した動作を指示するコマンド。 
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各項目毎に詳細内容を、各行に１項目毎記載することで、コマンドを指示する。 

 

 
 

B.4.2 基本書式応答 （機器からセンターマシンへ） 

状態情報取得フェーズで使われる TextData として、書式を定義する。 

必ず、機器からセンターマシンへ送信される為、状態情報取得フェーズで、扱われる。 

拡張子:「.txt」ファイル:ASN.1 表記で定義し、RFC3641 に準拠すること 

コマンド指示の項目に対応した応答内容を、TextData として配信することで、応答を示す。 

 

 
 

ResponceStart 

 StatusResponse 

FailCounterJam1:673 要求項目の Jam1 発生回数：673 回 

 ComsumptionCounterInkTonerBlack:13459 要求項目の黒のトナーの使用枚数：13459 page 印刷 

CurrentStatus:Idle  共通項目、現在待機中 

CommandActivate 

EndResponce 

CommandStart 

StatusResponse  ①機器の状態情報の応答を要求する機能。 

FailCounterJam1 Jam1 の発生回数を要求 

ComsumptionCounterInkTonerBlack トナー：黒の使用状態を要求 

CurrentStatus  現在の機器の状態を要求 

CommandActivate ②特定の設定項目を、機器に反映させる機能。 

EndCommand 
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B.4.3 構文定義、拡張手法 

各基本書式指示・応答の書式の構文。拡張方法を示し、共通項目と各社固有の拡張項目を明確にする。 

 

B.4.3.1 基本書式指示における構文、拡張方法 

構文 

 
 
大きく２つのブロックに分割し、各項目で実行内容は異なる。新たな実行・指示内容の拡張は、

"EndCommand"との間に追加する形式で拡張を可能とする。 
 

B.4.3.1.1. StatusResponse 

機器の状態に関する応答を求める情報を記載する。各項目は、","で分離して記載する。 

共通項目として、"CurrentStatus"のみを設定している。 

拡張領域として、詳細内容を、Strings で、記載することで、各社独自の状態情報の取得を行う。 

 

B.4.3.1.2. CommandActivate 

機器に存在する各種設定項目に対する、設定値を、設定項目と設定値を対で記載する。 

共通項目としての値は、定義しない。 

拡張領域として、設定項目名称 と 設定値を、","で区切って定義。各設定項目は、";"で区分する。 

 

B.4.3.1.3. 新規 Command の定義 

新しく、機器への指示コマンドの定義は、行の追加で行う。 

共通項目の定義及び、拡張領域の定義は、任意とする。 

 

B.4.3.1.4. ContentsExist 

機器に取得してほしい、コンテンツ情報が、センターマシン上に存在していることを示す。 

存在する場合:Yes を記載し、その後","にて、取得ファイル名称一覧を記載する。 

存在しない場合:No を記載。 

 

B.4.3.2 基本書式応答における構文、拡張方法 

構文 

CommandStart 

StatusResponse  ①機器の状態情報の応答を要求する機能。 

String1,String2,String3,String4 拡張領域 

CurrentStatus   共通項目 

CommandActivate ②特定の設定項目を、機器に反映させる機能。 

 String20-1,String20-2;String21-1,String21-2;  拡張領域 

Commandxxxxx ③新規の指示コマンドを定義拡張する場合 

 Srtingxx,String yy   拡張領域 

Contentsexist   ④機器に取得してほしいコンテンツ情報が、センターマシンに存在する事を示す。 

 Yes,xxxx.pdf,yyyy.Jpeg, zzzz.mpg   存在の有無と、存在する場合のファイル名称一覧 

EndCommand 



ＴＲ－１０３８ - 104 - 

 
 
基本書式指示と同じブロックが存在し、各項目で取得情報を対比させて、応答として渡す。基本書式指示

で、新たな実行・指示内容が拡張された場合には、同様に、"End Response"との間に追加し、応答内容を定

義して、拡張を可能とする。 
 

B.4.3.2.1. Status Response 

機器の各状態結果を、各項目に対比させて、";"で、状態を記載する。 

共通項目として、"Current Status"の応答は、 

 

Idle……待機状態で、処理は実施していない状態を示す。 

Busy….ジョブを処理し、稼働中であることを示す。 

Error…..何らかのエラー状態であり、動作が継続できない状態を示す。 

Sleep….待機状態で、省エネ状態であることを示す。 

 

で定義する。 

記載例:CurrentStatus;Busy 

 

B.4.3.2.2. Command Activate 

設定項目の反映結果を応答する。 

設定項目に対応し、結果を、";"で応答する。 

 

Done…..正しく設定が、機器に反映されたことを示す。 

Active…コマンド指示は、認識し現在実行中であることを示す。 

Fail…..何らかの理由で、設定が、反映できていないことを示す。 
 

ResponceStart 

 StatusResponse 

String1:xxx,String2:yyy,String3:zzz,String4:aaa 拡張領域 

Current Status:Idle  共通項目 

Command Activate 

  String20-1,Done;String21-1,Fail; 拡張領域 

 Commandxxxxx 

  Stringxx,xxxx;Stringyy,yyy; 

ContentsGetResponse 

  Xxxx.pdf,Yyyy.Jpeg 

EndResponse 
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B.4.3.2.3. 新規 Command の応答定義 

新しく、機器への指示コマンドを定義した場合に、その応答に関しても、行の追加で行う。 

共通項目の定義及び、拡張領域の定義は、任意とする。 
 

B.4.3.2.4. ContentsGetResponse 

機器が、取得できたコンテンツ情報を記載し、機器での取得結果をセンターマシンへ告知する。 
 

B.4.4 その他の規定 

同時に複数の TextData のファイル指示・応答を可能とする。 
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B.5 シーケンス 

いくつかのシーケンスを以下に示し、リモートメンテナンス機能の各項目を示す。特にコンテンツ転送方

向の変化等に注意のこと。AnnexB に関する部分について記述する。コンテンツ転送の基本部分の記載は本

編を参照すること。 
 

B.5.1 シーケンス 1 （コンテンツ送信、機器発信の場合） 

概要:機器が能動的に、機器の基本状態を発信する。発信トリガ及び発信内容は、任意の設定を可能とする。 

状態情報は、内容により複数の TestData での構成を可能にする。機器が、全ての状態情報の送信を完了した

時点で、機器は接続の切断フェーズへと移行する。 

状態情報送信フェーズは、本編図 9-5 の接続形態２のコンテンツ送信フェーズに相当する。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 B- 1／TR-1038 機器から状態情報を発信し、センターマシンが受信するシーケンス図 

発呼機器 

（機器） 
SIP サーバ 

着呼機器 

（ｾﾝﾀｰﾏｼﾝ） 

呼設定フェーズ 

TCP セッション確立フェーズ 

能力確認フェーズ 

状態情報送信フェーズ 1 

状態情報送信フェーズ n 

TCP セッション切断フェーズ 

F-B1 暫定応答要求<Expect: 100-Continue> 

F-B4 コンテンツ 1 送信応答<HTTP 200 OK> 

F-B5 暫定応答要求<Expect: 100-Continue> 

F-B6 暫定応答<HTTP/1.1: 100 Continue > 

呼切断フェーズ 

アウト 
チャネル 

イン 
チャネル 

アウト 
チャネル 

F-B2 暫定応答<HTTP/1.1: 100 Continue> 

F-B3 コンテンツ 1 送信<HTTP POST> 

F-B8 コンテンツ n 送信応答<HTTP 200 OK> 

F-B7 コンテンツ n 送信<HTTP POST> 

ジョブ生成フェーズ 
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B.5.2 シーケンス 2 （コンテンツ取得、センターマシン発信の場合） 

概要:センターマシンの要求に従って、機器の状態・カウンター各種機器側保有データを返送する。 

センターマシンは、発信した要求項目の応答が全て、機器から返送されるまで、"状態情報取得フェーズ"を

継続し、取得完了後に、センターマシンが、接続の切断フェーズへと移行する。 

着呼機器は、AnnexB での接続状態であり、状態情報コマンドフェーズにて、ファイルを取得したことをト

リガにして、接続形態２から１へと変更する。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 B- 2／TR-1038 センターマシンが状態情報の要求を発信し、機器から状態情報を取得するシーケンス図 

発呼機器 

（ｾﾝﾀｰﾏｼﾝ） 
SIP サーバ 

着呼機器 

（機器） 

呼設定フェーズ 

ジョブ生成フェーズ 

能力確認フェーズ 

状態情報コマンド指示フェーズ 

状態情報取得フェーズ 

TCP セッション切断フェーズ 

F-B9 暫定応答要求<Expect: 100-Continue> 

F-B12 コンテンツ送信応答<HTTP 200 OK> 

F-B13 暫定応答要求<Expect: 100-Continue> 

F-B14 暫定応答<HTTP/1.1: 100 Continue> 

呼切断フェーズ 

F-B17 暫定応答要求<Expect: 100-continue> 

F-B20 コンテンツ取得送信<HTTP 200 OK> 

アウト 
チャネル 

イン 
チャネル 

アウト 
チャネル 

F-B10 暫定応答<HTTP/1.1: 100 Continue > 

F-B11 コンテンツ送信<HTTP POST> 

F-B15 状態情報リスト取得要求<HTTP POST> 

F-B16 状態情報リスト取得応答<HTTP 200 OK>

F-B19 コンテンツ取得要求<HTTP GET> 

F-B18 暫定応答<HTTP/1.1: 100 Continue > 

TCP セッション確立フェーズ 
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B.5.3 シーケンス 3 （機器が発信し、センターマシンによるコンテンツ取得後、新たなコンテンツ転送） 

概要:機器が能動的に、機器の基本状態を発信する。発信トリガ及び発信内容は、任意の設定を可能とする。

最新情報を取得したセンターマシンは、機器の状態に応じて、機器へ新たなコンテンツを取得させる。機器

の新規コンテンツ取得フェーズにおける、"コンテンツリスト取得応答"により、新たなコンテンツがないこ

とが判明した時点で、機器は接続の切断フェーズへと移行する。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 B- 3／TR-1038 機器から状態情報発信後、センターマシンからの追加コンテンツを取得するシーケンス

図 
 

発呼機器 

（機器） 
SIP サーバ 

着呼機器 

（ｾﾝﾀｰﾏｼﾝ） 

呼設定フェーズ 

TCP セッション確立フェーズ 

能力確認フェーズ 

状態情報送信フェーズ 1 

状態情報送信フェーズ n 

TCP セッション切断フェーズ 

呼切断フェーズ 

アウト 
チャネル 

イン 
チャネル 

アウト 
チャネル 

機器の新規コンテンツ取得フェーズ 

F-B21 暫定応答要求<Expect: 100-Continue> 

F-B24 コンテンツリスト取得応答<HTTP 200 OK> 

F-B25 暫定応答要求<Expect: 100-Continue> 

F-B28 コンテンツ取得送信<HTTP 200 OK> 

ここまでは、「B.5.1 項 シーケンス 1」と同じ 

F-B22 暫定応答<HTTP/1.1: 100 Continue > 

F-B23 コンテンツリスト取得要求<HTTP POST> 

F-B26 暫定応答<HTTP/1.1: 100 Continue > 

F-B27 コンテンツ取得要求<HTTP GET> 

ジョブ生成フェーズ 
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付属資料C AnnexC 遠隔操作 

 

本版では未規定 
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付属資料D AnnexD 動画制御 

 

本版では未規定 
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